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Financial Processing
Overview

This chapter describes how to access the Financial Processing features.
This chapter includes the following information:

*

“About Financial Processing” on page 2
+  “Accessing Financial Processing From the Home Page” on page 5
+  “Accessing Financial Processing From the Work Page” on page 6

+  “Accessing Financial Processing Features From the Financial
Processing Page” on page 7
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About Financial Processing
Financial Processing is comprised of the following features:
¢ Chapter 2, “Voucher Entry,” beginning on page 9

Voucher Entry is a centralized place to enter vouchers in to the
system. It is a mini voucher system, where the user can enter time,
materials, expenses and equipment, and assign them to resources,
clients and projects with associated voucher numbers and vendor
codes.

¢ Chapter 3, “Post to Work In Process (WIP),” beginning on page 21

WIP controls the accounting phases of a transaction. The WIP Post
is the most powerful phase gate in the system. Once a transaction
has been posted to WIP, it has passed all validation criteria to be
entered into the system. WIP is where all costs on a project are
captured and capitalized. Transactions do not become available for
processing in the accounting system until they are posted to WIP.

¢ Chapter 4, “Create WIP Adjustments,” beginning on page 29

The purpose of WIP Adjustments is to make certain corrections to
posted WIP transactions. WIP entries often represent committed
items for which values may have been posted to General Ledger.
Therefore, it is important that access to this feature be tightly
controlled. The financial/accounting area of the company will
normally administer access to Create WIP Adjustments.

¢ Chapter 5, “Approve WIP Adjustment,” beginning on page 49

Approve WIP Adjustment enables a second level involved in
determining if WIP adjustments are accurate and necessary. All
WIP adjustments need to be approved.

¢ Chapter 6, “AR Integration,” beginning on page 63

Posting to Accounts Receivable transfers invoice and credit memo
information originating in Niku 6 to the AR module.
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Chapter 7, “Estimates To Complete (ETC) Processing,” beginning
on page 69

The RM-PM Link is the current integration between the project
plan and the project accounting modules. The project plan collects
ETCs and actuals. The relationship between the Budget, Actuals
and ETCs is an intricate one.

Chapter 8, “Revenue Recognition,” beginning on page 77

Financial Management offers the capability to recognize revenue
on a percentage of complete (POC) basis. For certain types of
projects, primarily long-term contracts and retainers, this method
of revenue recognition is required. Financial Management POC
generates and records transactions that can be posted to the
General Ledger for revenue recognition on projects where POC is
appropriate. The revenue recognition transactions typically affect
revenue and deferred revenue categories of General Ledger
accounts.

Chapter 9, “Transaction Archive,” beginning on page 85

In order to optimize performance, customers need the ability to
archive projects. The user may designate how often the company
wants the transactions to be archived when creating a project.
Project transactions can be archived automatically at the end of the
project, a prompt can suggest archiving at the end of the project, or
the user can select when to archive the project transactions. The
users also need a method to access records that have been
archived.

Chapter 10, “Niku GL Integration,” beginning on page 93

Niku integration to a GL module allows users to collect
information for ongoing internal and client projects, and post
transactions in summary from Niku to the GL. Transaction
information available to be posted includes time, revenue,
expenses, adjustments and costs.

Chapter 11, “Niku Financial Integrations,” beginning on page 123
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Niku Financial Integrations provides the same user interface when
distributing costs to projects in Niku, whether accessed through an
Accounts Payable (AP), Inventory (1V), or Purchase Order (PO)
module, or directly. Niku Financial Integrations performs the tasks
of distributing costs, generating reports and posting distributions
by client, project, cost code, and employee from the third-party
module to Revenue Niku.
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Accessing Financial Processing From the Home Page

The Home Page enables you to navigate throughout the Niku 6 to
include the Financial Processing features.
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To access the Financial Processing features, log into Niku 6. From the
Home Page, under Work, click Financial Processing. On the Financial
Processing Page, click on the desired feature link on the left.
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Accessing Financial Processing From the Work Page

The Financial Processing features can be accessed from the Work Page.
The Work Page is accessed in two ways:

¢ From the Home Page, click on the launch button to the left of Work.

+ You have been sent to the Work Page by completing/canceling a
previous Financial Processing feature.

ﬁf‘ *:‘T ﬁ Niku Confidential & ? R
&5

Projects

]

-
Project « ProjectD  Client Code  Risk Status Collaboration
E-Commerce Websits in XML WR-09 1321 B O HEX
Fiscal plan '02 BG-2 54 O o SGES
Prototype 1 AD-L SHER
Business Development LK-69 & o & ES
Market Survey 184 a6 SER
Ul Rebrand JE-9 1654 g o HEX
Software Development 511936 5432 [ > I ] E &
Broduct Testing AS-87 O | =N =
SRM 6.0 £5-3 0O o S%EX
Product Planning BHE-4 o o HER
Marketing HR-S O B SES
UI Verification AHS-2 21657 SHER

— I

h Bil

Print h Billing

Methodology
Authoring

©2001, Niku Corporation | @ 4% @ : & |4

6 Niku 6 Financial Processing User’s Guide



The Financial Processing features can be accessed directly on the Work
Page by clicking the desired feature link on the left side of the Page
under Financial Processing.

Accessing Financial Processing Features From the
Financial Processing Page

The Financial Processing Page enables you to access any of the financial
processing features. These features include:

¢ Voucher Entry

¢ Postto WIP

¢ Create WIP Adjustment

¢+ Approve WIP Adjustment
¢+ AR Integration

+ Estimates to Complete

¢ Revenue Recognition

¢ Transaction Archive

¢ GL Integration

¢ Financial Integrations

+ Reports
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To view the Financial Processing Page from the Home Page, under
Work click the <Financial Processing> Link.

Niku Confidential

Adjustment Approvals Pending

Program/Project External ID Manager Start Finish Risk  Status
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You can get to a Financial Processing feature is by clicking the feature
link on the left side of the Financial Processing Page.
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Voucher Entry

This chapter describes how to view and create vouchers. This chapter
includes the following information:

¢ “About Voucher Entry” on page 10
*  “Voucher Entry Page” on page 11

+  “Voucher Entry Detail Page” on page 16
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About Voucher Entry

Voucher Entry is a centralized place to enter vouchers in to the system.
It is a mini voucher system, where the user can enter time, materials,
expenses and equipment, and assign them to resources, clients and
projects with associated voucher numbers and vendor codes.
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Voucher Entry Page

The Voucher Entry Page enables you to search for, create new and delete
vouchers.

To view the Voucher Entry Page from the Home Page, under Work click
Financial Processing » Voucher Entry.

To view the Voucher Entry Page from the Work Page, under Financial
Processing click the <Voucher Entry> Link.

To view the Voucher Entry Page from the Financial Processing Page,
click the <Voucher Entry> Link.

Niku ik o &1

Work » Financial Processing » Youcher Entry

Search
Voucher [ Employes Browse
Clent [ prowse Fombate [
Proiect [ growse Tobae [
Transaction Class [all - Wendor Browse
Cost Code Browse P. 0. Number
~—+ Search | Clear | Cancel
Results

perform a search to find results,

& Voucher Client Project Employee Transaction Date
[ CLIEMTOL Jooos Gray, Brian 6/15/01
M As-DATE-TEST CLIENTO1 Jooos Beyer, Bob 5/4/99
[ DeOi CLIEMTO1 Jooos Beyer, Bob 6/19/01
™ peoz CLIENTO1 10010 Beyer, Bob 6/19/01
T RATEGUY CLIENTO1 10005 Alters, Paul 6/16/01
—+  Mew Lahor Mewr Material New Equipment New Expense I Delete

ik Gomoration) 1 - & @ & (&

The following table describes the items that appear on the VVoucher
Entry Page.
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Item Description

Search Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Voucher Entry Page. See “How
to Search for a Voucher” on page 14.

Clear Clears the search attribute fields.

Cancel Cancels the action and returns to the Financial
Processing Page.

New Labor Allows you to create a new voucher with a
Transaction Class of Labor. See “How to
Create a New Voucher” on page 14.

New Material Allows you to create a new voucher with a

New Equipment

New Expense

Delete

Transaction Class of Material. See “How to
Create a New Voucher” on page 14.

Allows you to create a hew voucher with a
Transaction Class of Equipment. See “How to
Create a New Voucher” on page 14.

Allows you to create a hew voucher with a
Transaction Class of Expenses. See “How to
Create a New Voucher” on page 14.

Allows you to delete a voucher by selecting the
Voucher checkbox and clicking <Delete>. See
“How to Delete a Voucher” on page 15.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

Client The Client Code is a unique identifier for the
client. Every client must have a Client Code
Project Grouping of all services (work) and goods to

12 Niku 6 Financial Processing User’s Guide

be provided for a given job.



Item

Cost Code

Description

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

+  Material
*  Equipment
¢ Expense

There is no limit to the number that can be
defined.

From Date

Restricts the search results to include only
those on or after the specified date.

To Date

Restricts the search results to include only
those on or before the specified date.

Transaction Class

Transactions are organized into classes:

¢ Labor

¢ Materials

¢ Equipment

* Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

Site

Employee Individuals who enter time spent on performing
their respective services for one or multiple
projects.

Voucher

Vendor

PO # Purchase Order Number.

Quantity

Cost

Voucher

Niku 6 Financial Processing User’s Guide
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Iltem Description

Client The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project Grouping of all services (work) and goods to
be provided for a given job.

Resource

Transaction Date

How to Search for a Voucher
To do a Search:

1 Inthe Search section on the Voucher Entry Page, enter any of the
search criteria.

2 Click <Search>.

3 The search results appear in the Results section on the Voucher
Entry Page.

How to Create a New Voucher
To create a new Voucher:
1 Do asearch. See “How to Search for a Voucher” on page 14.

2 Check the Results section of the Voucher Entry Page to make sure
the voucher you want does not exist.

3 Click on <New Labor>, <New Material>, <New Equipment>, or
<New Expense> (depending on the Transaction Class of the new
voucher you want to create).

4 The Voucher Entry Detail Page appears. See “Voucher Entry Detail
Page” on page 16.
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How to Delete a Voucher
To delete a Voucher:
1 Do asearch. See “How to Search for a Voucher” on page 14.

2 Inthe Results section of the Voucher Entry Page, select the Voucher
you want to delete by clicking in the checkbox.

3 Click on <Delete>.

4 The Voucher is deleted.

How to View an Existing Voucher
To view an existing Voucher:
1 Do asearch. See “How to Search for a Voucher” on page 14.

2 Inthe Results section of the Voucher Entry Page, under the Voucher
column, click on the link of the Voucher you want to view.

3 The Voucher Entry Detail Page appears. See “Voucher Entry Detail
Page” on page 16.
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Voucher Entry Detail Page

The Voucher Entry Detail Page enables you to create a new voucher,
view an existing voucher, calculate a new rate or recalculate totals.

To view the Voucher Entry Detail Page (for a new voucher) from the
Home Page, under Work click Financial Processing » Voucher Entry.
Click on the <New Labor>, <New Material>, <New Equipment>, or
<New Expense> button.

To view the Voucher Entry Detail Page (for a new voucher) from the
Work Page, under Financial Processing click on Voucher Entry. Click on
the <New Labor>, <New Material>, <New Equipment>, or <New
Expense> button.

To view the Voucher Entry Detail Page (for an existing voucher) from
the Voucher Entry Page, look in the Results section of the Voucher Entry
Page. Under the Voucher column, click on the link of the Voucher you
want to view.

Work » Financial Processing » ¥oucher Entry » Youcher Entry Detail

Voucher

Bvoucher [
TransactonDate [eriaor

P.O.Number

Transaction Class Labor

@clent [ arowse
BProject [ growee
Projectsie [ | prowse
moostCote [ prowse
mEmployee [ prowse

—  Submit

Calculate New Rate

Re-Calculate Totals

Hours
B Minutes
B Rate

Total Amount
onsite
Chargeable [~

Notes B

| cancei

- Required

©®2001, Niku Corporation. 4% - 48 @ & &

The following table describes the items that appear on the Voucher

Entry Detail Page.
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Item

Submit

Calculate New Rate

Re-Calculate Totals

Cancel

Browse (link)

Voucher

Description

Saves and submits a new voucher. See “How
to Submit a New Voucher” on page 19.

Note: Prior to submitting a new voucher, it can
be modified during input by clicking the
appropriate field and changing the attributes.
Once a voucher has been submitted, it cannot
be changed.

Calculates the new rate after changes are
made to the attribute fields. See “How to
Calculate a New Rate” on page 19.

Note: All required fields must be entered
before calculating. The new rate is not saved
unless the voucher is submitted.

Re-calculates the total after changes are made
to the attribute fields. See “How to Recalculate
the Total” on page 19.

Note: All required fields must be entered
before recalculating. The new total is not
saved unless the voucher is submitted.

Cancels the action and returns to the Financial
Processing Page.

Browse for an object or set of objects to
include in the filtering criteria.

Vendor

PO #

Purchase Order Number.

Transaction Date

Niku 6 Financial Processing User’s Guide
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Item

Transaction Class

Client

Project

Project Site

Description

Transactions are organized into classes:
¢ Labor

¢ Materials
¢ Equipment
¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.

Cost Code

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

¢ Material
¢+ Equipment
¢ Expense

There is no limit to the number that can be
defined.

Resource

Quantity
Price
Cost

Total Amount

Chargeable

18 Niku 6 Financial Processing User’s Guide
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Item Description

Total Amount

Notes

How to Submit a New Voucher

Note: Prior to submitting a new voucher, it can be modified during
input by clicking the appropriate field and changing the attributes. Once
a voucher has been submitted, it cannot be changed.

To create a new voucher:
1 Enter the data in the Voucher Information section.
2 Enter the data in the Entry Information section.

3 Click <Submit>.

How to Calculate a New Rate

Note: All required fields must be entered before calculating. The new
rate is not saved unless the transaction is submitted. If you do not want
to save this new rate, click <Cancel>.

To calculate a new rate:
1 Make the appropriate changes in the attribute fields:
2 Click <Calculate New Rate>.

3 If this transaction is to be submitted, click <Submit>.

How to Recalculate the Total

Note: All required fields must be entered before recalculating. The new
total is not saved unless the transaction is submitted. If you do not want
to save this new total, click <Cancel>.

To recalculate the total:

1 Make the appropriate changes in the attribute fields:

Niku 6 Financial Processing User’s Guide
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2 Click <Recalculate Total>.

3 If this transaction is to be submitted, click <Submit>.
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Post to Work In Process
(WIP)

This chapter describes how to post and preview Work In Process. This
chapter includes the following information:

¢ “About Post to Work In Process” on page 22
¢ “Post to WIP Page” on page 23

+  “Preview Page” on page 26
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About Post to Work In Process

Work in Process (WIP) is the most important, fundamental concept in
the project accounting domain. The set of tables that make up WIP
contain every transaction that is entered into the accounting system.

WIP controls the accounting phases of a transaction. The WIP Post is the
most powerful phase gate in the system. Once a transaction has been

posted to WIP, it has passed all validation criteria to be entered into the
system. WIP is where all costs on a project are captured and capitalized.

Transactions do not become available for processing in the accounting
system until they are posted to WIP. The accounting staff are
periodically required to post transaction to WIP so that they can perform
billing, invoicing, posting to Accounts Receivable (AR), posting to
General Ledger (GL) and WIP adjustments.

There are two types of postings:

¢ Full Post — Users who wish to post all accumulated transactions for
a specified time period that have been entered into the system for
project accounting purposes would choose to do a full post. A full
posts would be performed if the total volume of transactions were
relatively small. Users can preview the total number of transactions
to be posted and decided to continue posting all the transactions.

¢ Selective Post — Users with large numbers of transactions to be
posted may choose to do a selective post. A selective post allows
flexibility to choose transaction types to post and/or locations,
clients, projects and employees. This narrows down the amount of
transactions to be posted at one time. This is also useful when there
are small amounts of transactions that had not been entered in time
during an accounting period.
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Post to WIP Page

The Post to WIP Page enables you to view transactions based on user
entered criteria in order to perform a Post to WIP.

To view the Post to WIP Page from the Home Page, under Work click

Financial Processing » Post to WIP.

To view the Post to WIP Page from the Work Page, under Financial

Processing click the <Post to WIP> Link.

To view the Post to WIP Page from the Financial Processing Page, click

the <Post to WIP> Link.

Niku Confidential

&7 X

Niku 1L 2

Work » Financial Processing » Post To WIP

@ From Date Resources
B To Date

Location Browse Labor
Remove

Material

Equipment

Client Codes Browse
Eemove Expense
POC
Projects Browse
Remove

++ Preview | Clear [ Cancel

o= Reguired

Browse
Remove

W

UBNCU

a =

© 2001, Niku Corporation

The following table describes the items that appear on the Post to WIP
Page.

Item Description

Allows you to preview transactions based on
information entered in the Post to WIP Page.
See “How to Preview a Post” on page 24.

Preview

Clear Clears all data fields.

Cancels current action and takes you to the
Financial Processing Page.

Cancel
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Item

Browse (link)

Remove (link)

Description

Browse for an object or set of objects to
include in the filtering criteria.

Remove an object or set of objects from the
filtering criteria.

From Date Restricts the search results to include only
those on or after the specified date.

To Date Restricts the search results to include only
those on or before the specified date.

Location Each Client has at least one Location, but
each Client may have multiple Locations.
Usually refers to the various physical locations
at which an Client performs business.

Client Code The Client Code is a unique identifier for the
client. Every client must have a Client Code

Projects Grouping of all services (work) and goods to
be provided for a given job.

Resources

Labor

Material

Equipment

Expense

POC Percentage Of Completion - A method of

revenue recognition for certain types of
projects, primarily long-term and retainer
contracts, on a percent of completion basis

How to Preview a Post
To preview a Post:
1 Enter data in one or more of the fields in the Selective Post section.

Note: To view all transactions (to perform a full post), you only need
to enter the From Date and To Date.
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2 Click <Preview> and the Preview Page appears. See “Preview
Page” on page 26.
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Preview Page

The Preview Page enables you to select items to post from the previewed
list.

To view the Preview Page from the Home Page, under Work click
Financial Processing » Post to WIP. Enter information in the fields and
click <Preview>.

To view the Preview Page from the Work Page, under Financial
Processing click the <Post to WIP> Link. Enter information in the fields
and click <Preview>.

H M =
Niku ik n 21 %
Work » Financial Pr Post To WIP Preview  Preview
Summary
From Date 1/1/99
ToDate 1/25/01
Transaction Class Labaor, Material, Equipment, Expense
Total Transactions 751
Items To Post
& Code Level Total
¥ BG Employees 41
¥ CHICAGO Locations 412
¥ CLIENTO1 Clients 154
¥ CLIENTD1:1000S Projects 144
—+ [Post| | Cancel
© 2001, Miku Corporation K @ & K

The following table describes the items that appear on the Preview Page.

Item Description

Post Posts all checkboxed items. See “How to Post
Iltems” on page 27.

Cancel Cancels action and takes you to the Post to
WIP Page.
From Date Restricts the search results to include only

those on or after the specified date.
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Item Description

To Date Restricts the search results to include only
those on or before the specified date.

Transaction Class Transactions are organized into classes:
¢ Labor

¢ Materials
¢ Equipment
+ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

Total Transactions

Level

Code

Total

How to Post Items
To Post selected items:
1 Click the checkbox for the transaction(s) that you want to post.

2 Click <Post>. The transactions are posted and the Post to WIP Page
appears.
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Create WIP Adjustments

This chapter describes how to modify, reverse or transfer a Work In
Process (WIP). This chapter includes the following information;

¢ “About Create WIP Adjustments” on page 30
+  “Create WIP Adjustment Page” on page 31

+  “Modify Transaction Page (for Equipment, Expenses and Material)”
on page 36

¢+ “Modify Transaction Page (for Labor)” on page 40
+ “Transfer Transaction Page” on page 44

* “Transfer Status Page” on page 47
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About Create WIP Adjustments

The purpose of WIP Adjustments is to make certain corrections to
posted WIP transactions. WIP entries often represent committed items
for which values may have been posted to General Ledger. Therefore, it
is important that access to this feature be tightly controlled. The
financial/accounting area of the company will normally administer
access to Create WIP Adjustments.

There are three types of WIP Adjustments: Modify, Reverse, and
Transfer.

+ Modify refers to changing the data within a transaction, such as the
number of hours worked, the rate charged in a labor transaction, or
the cost for a materials transaction.

* Reverse generates a transaction that cancels the original transaction,
and provides a complete audit trail.

+ Transfer occurs when a transaction or set of transactions is moved
from one entity, client, cost code or employee to another at the same
level of grouping. The transfer generates an automatic reversing
entry along with the new replacement entry.

To ensure data integrity, when a WIP Adjustment is entered, the
associated WIP transaction(s) are placed on hold until the WIP
Adjustment has been approved. Therefore, WIP items awaiting WIP
adjustment approval are not available for billing even though they are
available for reporting.
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Create WIP Adjustment Page

The Create WIP Adjustment Page enables you to modify, reverse or
transfer a WIP transaction.

To view the Create WIP Adjustment Page from the Home Page, under
Work click Financial Processing » Create WIP Adjustment.

To view the Create WIP Adjustment Page from the Work Page, under
Financial Processing click the <Create WIP Adjustment> Link.

To view the Create WIP Adjustment Page from the Financial Processing

Page, click the <Create WIP Adjustment> Link.

Niku ﬁ} ﬁ @ @ Niku Cenfidential &7 X

Work » Financial Processing » Create WIP Adjustment

Search

O From Date Project Browse
B To Date Cost Code Browse
Transattion Class [ll - GCostvariation [Cast Vanation Valus =
Client Browse Resource Browse
— Clear | | Cancel

Results

To Modify a transaction, click on the Date.
£ Date Transaction Class  Client Project ProjectSite  CostCode Resource Chargeable  Quantity Total (SUSD)
Labar
C 01f10/2000 CLICK ME! Client1s J1s00 Banff Deliver Pa s 100 2000.00
™ 0s/13/2000 Labor Client1s J1soo Banf Deliver PA 4 100 3151.01
M ououeooy  fEeeral CLIENT30 13001  NEWYORK  CNTRACT  PA1 1.0000 1500.00

@ = Required

++  Reverse Transfer

4 @ &

The following table describes the items that appear on the Create WIP
Adjustment Page.
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Iltem

Search

Clear

Description

Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Create WIP Adjustment Page.
See “How to Search for a WIP Transaction” on
page 34.

Clears the search attribute fields.

Cancel

Cancels the action and returns to the Financial
Processing Page.

Modify

Reverse

Allows you to modify a transaction by selecting
the Transaction checkbox and clicking
<Modify>. See “How to Modify a WIP
Transaction” on page 34.

Allows you to reverse a transaction by
selecting the Transaction checkbox and
clicking Reverse. See “How to Reverse a WIP
Transaction” on page 34.

Transfer

Allows you to transfer a transaction by
selecting the Transaction checkbox and
clicking Transfer. See “How to Transfer a WIP
Transaction” on page 35.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

From Date

Restricts the search results to include only
those on or after the specified date.

To Date
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Item

Transaction Class

Client

Project

Cost Code

Description

Transactions are organized into classes:
¢ Labor

¢ Materials
¢ Equipment
+ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

+  Material
* Equipment
¢ Expense

There is no limit to the number that can be
defined.

Cost Variation

Resource

Date

Chargeable A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.

Quantity

Total
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How to Search for a WIP Transaction

To do a Search:

1

In the Search section on the Create WIP Adjustment Page, enter any
of the search criteria.

Click <Search>.

The search results appear in the Results section on the Create WIP
Adjustment Page.

How to Modify a WIP Transaction

To modify a WIP transaction:

1

2

3

Do a search. See “How to Search for a WIP Transaction” on page 34.
Click the <Date> Link next to the transaction that is to be modified.

The Modify Transaction Page appears. See “Modify Transaction
Page (for Equipment, Expenses and Material)”” on page 36 or
“Modify Transaction Page (for Labor)” on page 40.

How to Reverse a WIP Transaction

Reverses to a transaction can be made if the following is true:

*

*

It has been Posted

It has been Approved

It is not currently in the Adjustment process

It has not been Billed or currently in the Billing process
It has not been Reversed

The project has not been closed
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Once a transaction search has been completed, perform the following
to reverse the transaction:

1 Onthe Create WIP Adjustment Page, click the checkbox next to the
transaction(s) that are to be reversed.

2 Click <Reverse>.

3 The transaction is reversed and is no longer seen in the Results
section of the Create WIP Adjustment Page.

How to Transfer a WIP Transaction
To transfer a WIP transaction:

1 On the Create WIP Adjustment Page, click the checkbox next to the
transaction(s) that are to be transferred.

2 Click <Transfer>.

3 The Transfer Transaction Page appears. See “Transfer Transaction
Page” on page 44.
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Modify Transaction Page (for Equipment, Expenses

and Material)

The Modify Transaction Page enables you to make changes to a WIP

transaction. Modifications or changes to a transaction can be made if the

following is true:

+ It has been Posted

*

It has been Approved

¢ Itis not currently in the Adjustment process

*

+ |t has not been Reversed

¢ The project has not been Closed

To view the Modify Transaction Page from the Create WIP Adjustment
Page, click the <Date> Link in the Results section, next to the transaction

that is to be modified.

It has not been Billed or currently in the Billing process

Niku Confidential

Work ) Financial Pr Create WIP Adj Modify Tr
— [Submit || Caleulate NewRate || Recalculate Total | | Cancel

m0ate [11/10/2001
B Transaction Class [Material =

B Client [CLIENT30 Browse

DFroject 13001 | Browse
OFojectSite [NEW VORK | Browse
BcostCode [ONTRACT | prowse

DCostvariation [ | Browss
BResource [PAL | Browse

& = Required

Calculate New Rate

vendar Code Browse
PO Number
mouantty [Looon
oRate [150000 | gusD
@Actual Cost [1500.00 | $UsD

Total 1500.00 §USD
Chargeakle 7

Notes -

— | ubmit Recalculate Total || Cancel

2001, hliku ¢

o

& @

The following table describes the items that appear on the Modify
Transaction Page (for equipment, expenses and material).
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Item

Submit

Description

Saves and submits a modified transaction.
See “How to Submit a Modification” on
page 38.

Calculate New Rate

Recalculate Total

Calculates the new rate after changes are
made to the attribute fields.

Note: The new rate is not saved unless the
voucher is submitted.

Re-calculates the total after changes are made
to the attribute fields.

Note: The new total is not saved unless the
voucher is submitted.

Cancel

Cancels the action and returns to the Create
WIP Adjustment Page.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

Date

Transaction Class

Client

Project

Project Site

Transactions are organized into classes:
¢ Labor

¢ Materials
* Equipment
¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.
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Item

Cost Code

Description

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

¢ Material
¢+ Equipment
¢ Expense

There is no limit to the number that can be
defined.

Cost Variation

Resource

Vendor Code
PO Number
Quantity

Rate

Actual Cost

Total

Chargeable

A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.

Notes

How to Submit a Modification

To submit a modification:

1 Make the appropriate changes in the attribute fields.
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2 If modifications were made that affect the rate or total, the
<Calculate New Rate> and the <Recalculate Total> buttons must be
clicked prior to submitting the modifications.

Note: If changes are made on screen that affect the rate or total, the
new rate or new total will not take affect until the <Calculate New
Rate> and the <Recalculate Total> buttons are clicked prior to
submitting.

3 Click <Submit>.
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Modify Transaction Page (for Labor)

The Modify Transaction Page enables you to make changes to a WIP
transaction. Modifications or changes to a transaction can be made if the

following is true:
¢ It has been Posted

¢ It has been Approved

¢ Itis not currently in the Adjustment process

¢ It has not been Billed or currently in the Billing process

+ It has not been Reversed

*

The project has not been Closed

To view the Modify Transaction Page from the Create WIP Adjustment
Page, click the <Date> Link in the Results section, next to the transaction

that is to be modified.

Niku Confidential

Work » Financial Pr Create WIP Adj Modify Tr
[ Bubmit || Calouiate NewRate || Recalouiate Total || Cancel
mDate [01/10/2001
BTransaction Class Labor
moiient [CLIENT1S Browse
@Prject 11500 Browse

mProjectSite [Banff Browse

B Cost Code [Deliver Browse

3 Cost Variation Browse

BResoure [PA

Browse

@ = Required

P —
B Minutes |0

orate 000 $usD
Total 200000 $USD
Chargeable
onsite 7
Notes [Uf Modifications =
=

Caloulate NewRate |

—+  Submit

Recaloulate Total | Cancel

The following table describes the items that appear on the Modify

Transaction Page (for labor).
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Item

Submit

Description

Saves and submits a modified transaction.
See “How to Submit a Modification” on
page 38.

Calculate New Rate

Recalculate Total

Calculates the new rate after changes are
made to the attribute fields.

Note: The new rate is not saved unless the
voucher is submitted.

Re-calculates the total after changes are made
to the attribute fields.

Note: The new total is not saved unless the
voucher is submitted.

Cancel

Cancels the action and returns to the Create
WIP Adjustment Page.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

Date

Transaction Class

Client

Project

Project Site

Transactions are organized into classes:
¢ Labor

¢ Materials
* Equipment
¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.
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Item

Cost Code

Description

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

¢ Material
¢+ Equipment
¢ Expense

There is no limit to the number that can be
defined.

Cost Variation

Resource

Hours
Minutes
Rate

Total

Chargeable

On Site

Notes

A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.

Indicates that the work was performed at the
client’s location.

How to Submit a Modification

To submit a modification:

1 Make the appropriate changes in the attribute fields.
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2 If modifications were made that affect the rate or total, the
<Calculate New Rate> and the <Recalculate Total> buttons must be
clicked prior to submitting the modifications.

Note: If changes are made on screen that affect the rate or total, the
new rate or new total will not take affect until the <Calculate New
Rate> and the <Recalculate Total> buttons are clicked prior to
submitting.

3 Click <Submit>.
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Transfer Transaction Page

The Transfer Transaction Page allows you to transfer a WIP transaction.
Transfers to a transaction can be made if the following is true:

¢ It has been Posted

¢ It has been Approved

¢ Itis not currently in the Adjustment process

+ It has not been Billed or currently in the Billing process

¢ It has not been Reversed

¢ The project has not been closed

To view the Transfer Transaction Page from the Create WIP Adjustment

Page, click the checkbox next to the transaction that is to be transferred
and click <Transfer>.

Niku m *_;J @ @ Niku Confidential & 7%

Work » Financial Pr i Create WIP Adj Transfer Tr

NOTE: THE FIELDS ON THIS PAGE I REEAL LIFE WILL DEPEND ON 4 USER'S SELECTIONS AND SEARCH FIELDS, THIS PROTOTYFE
SCREEN ONLY DEMONSTRATES THE FROM AND TO COLUMMNE; ACTUAL FIELDS MAY DIFFER.

[ Bubrmit | | Gancel
Transfer From Transfer To
Date 12/20/2000 OwerrideDate [
Transaction Class Al Transaction Class [&l 2]
client Client1s Bclient [Clientis Browse
Project 11500 @project [
Froject Site New York Project Site [New York Browse
CostCode Deliver CostCode [Deliver  Browse
Resource Jaquish, Matt Chargsable [
Chargeahle [@ Costvariation [ | arowse

Resource [laguish, Matt Browse
Calculate New Rates [

Notes

&= Required

+—  Bubmit | Cancel

1, Niku Comoration. 117 - §3 @ % 4

The following table describes the items that appear on the Transfer
Transaction Page.
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Item Description

Submit Saves and submits a transferred transaction.
See “How to Submit a Transfer Transaction”
on page 46.

Cancel Cancels the action and returns to the Create

WIP Adjustment Page.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

Date
Override Date

Transaction Class

Client

Project

Project Site

Cost Code

Transactions are organized into classes:
¢ Labor

¢ Materials
*  Equipment
+ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

*  Material
*  Equipment
¢ Expense

There is no limit to the number that can be
defined.
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Iltem Description

Chargeable A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.

Cost Variation

Resource

Calculate New Rates

Notes

How to Submit a Transfer Transaction
To submit a transfer transaction:
1 Make the appropriate changes in the attribute fields:
2 Click <Submit>.

3 The Transfer Status Page appears. See “Transfer Status Page” on
page 47.
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Transfer Status Page

To view the Transfer Status Page from the Transfer Transaction Page,
make the appropriate changes in the attribute fields and click <Submit>.

Niku ﬁ} ﬁ @ @ Niku Cenfidential &7 X

Work » Fi Pi i Create WIP

Transfer Tr

Transfer Status

Transaction
% Date Class

[ 01/10/2000 Labar
[T 05/13/2000 Labor

[0 01/01/2001 Labaor

Client

CLIENT30 13001 TRNCBT S5

CLIENT30 13001 PROIMGMT Pa

CLIENT30 13001 CNTRACT PAl Success

Project CostCode Resource Message

Project or Project Changearder not found on projects table for
cinteode/projid combination

Projest or Projest Changearder not found on projects tabls for
clntrade/prajid combination

— | Continue

il @ &

The following table describes the items that appear on the Transfer

Status Page.

Item

Continue

Description

Returns you to the Create WIP Adjustment
Page.

Date

Transaction Class

Transactions are organized into classes:

¢ Labor

¢ Materials

* Equipment

¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

Client

The Client Code is a unique identifier for the
client. Every client must have a Client Code
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Iltem Description

Resource

Message
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Approve WIP Adjustment

This chapter describes how to approve a Work In Process (WIP). This
chapter includes the following information:

¢ “About Approve WIP Adjustment” on page 50
+  “Approve WIP Adjustment Page” on page 51
+ “Details Page (Transferred Transaction)” on page 56

¢ “Details Page (Reversed Transaction)” on page 59
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About Approve WIP Adjustment

Approve WIP Adjustment enables a second level involved in
determining if WIP adjustments are accurate and necessary. All WIP
adjustments need to be approved.
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Approve WIP Adjustment Page

The Approve WIP Adjustment Page enables you to approve or reject a

WIP adjustment.

To view the Approve WIP Adjustment Page from the Home Page, under
Work click Financial Processing » Approve WIP Adjustment.

To view the Approve WIP Adjustment Page from the Work Page, under
Financial Processing, click <Approve WIP Adjustment> Link.

To view the Approve WIP Adjustment Page from the Financial
Processing Page, click <Approve WIP Adjustment> Link.

Niku ﬁ} ﬁ @ @ Niku Cenfidential &7 X

Work » Financial Processing ' Approve WIP Adjustment

Search

© From Date Client Browse
B To Date Froject Browse
Transattion Class [&ll b Cost Code Browse
Adjustment Type |All B Employee Browse
—+ [(Bearsh | [ciear | | cancel
Results
€ Date Adjustment Type  Transaction Class  Client Project CostCode Resource Quantity (SUSD)  Amount (SUSD)
[ 12/19/2000 Reverse Labor CLICKME  Customer 1000 11500  Deliver P 275000 275000
[0 01/10/2001  Transfer Labor AND ME Client 15 11500 Deliver A 2750.00 2750.00
™ 12/20/2000  Modify Expense Client 15 11500 Deliver dharron 2750.00 2750.00
@ = Required
s Approve | Reject

©2001, Niku Coporation. 14} 4 @« & (4

The following table describes the items that appear on the Approve WIP

Adjustment Page.

Item

Search

Clear

Description

Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Approve WIP Adjustment Page.
See “How to Search for a WIP Adjustment” on
page 54.

Clears the search attribute fields.
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Item

Cancel

View

Description

Cancels the action and returns to the Financial
Processing Page.

Allows you to view a WIP Adjustment by
clicking the checkbox next to the Date by the
Adjustment Type that you want to view. The
Details Page appears. See “How to View a
WIP Adjustment” on page 54.

Approve

Approves a WIP Adjustment transaction. See
“How to Approve a WIP Adjustment (Without
Viewing)” on page 54.

Reject

Rejects a WIP Adjustment transaction. See
“How to Reject a WIP Adjustment (Without
Viewing)” on page 55.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

From Date

Restricts the search results to include only
those on or after the specified date.

To Date

Restricts the search results to include only
those on or before the specified date.

Transaction Class

Transactions are organized into classes:

¢+ Labor

¢ Materials

¢  Equipment

¢+ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many

Transaction Types as required, for a given
Transaction Class.

Adjustment Type

Client

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project
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Item

Cost Code

Description

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

+  Material
*  Equipment
¢ Expense

There is no limit to the number that can be
defined.

Employee

Date

Individuals who enter time spent on performing
their respective services for one or multiple
projects.

Adjustment Type

Transaction Class

Transactions are organized into classes:

¢ Labor

+ Materials

¢ Equipment

¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

Client The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project Grouping of all services (work) and goods to
be provided for a given job.

Resource

Quantity

Amount
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How to Search for a WIP Adjustment

To do a Search:

1

In the Search section on the Approve WIP Adjustment Page, enter
any of the search criteria.

Click <Search>.

The search results appear in the Results section on the Approve WIP
Adjustment Page.

How to View a WIP Adjustment

To view a WIP Adjustment:

1

2

Do a search. See “How to Search for a WIP Adjustment” on page 54.

In the Results section, click on the checkbox next to the Date by the
Adjustment Type that you want to view.

The Details Page appears. See “Details Page (Transferred
Transaction)” on page 56 or “Details Page (Reversed Transaction)”
on page 59.

How to Approve a WIP Adjustment (Without Viewing)

To approve a WIP Adjustment:

1

In the Results section, click on the checkbox next to the Adjustment
Type that you want to approve.

Note: More than one checkbox can be selected. However, all
selected will be approved.

Click <Approve>.
The selected WIP Adjustment is approved.

The WIP Adjustment is removed from the Results section of the
Approve WIP Adjustment Page.
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How to Reject a WIP Adjustment (Without ViewingQ)
To reject a WIP Adjustment:

1 Inthe Results section, click on the checkbox next to the Adjustment
Type that you want to reject.

Note: More than one checkbox can be selected. However, all
selected will be rejected.

2 Click <Reject>.
3 The selected WIP Adjustment is rejected.

4 The WIP Adjustment is removed from the Results section of the
Approve WIP Adjustment Page.
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Details Page (Transferred Transaction)

The Details Page displays WIP Adjustments that have been submitted

for approval.

To view the Details Page from the Approve WIP Adjustment Page, click
the <Date> Link next to the Adjustment Type in the Results section that
you want to view.

Work » Financial Pr

L I e

Niku Confidential

Approval  Details

Transferred Transaction

— Reject || Cancel

Original Transaction

Modified Transaction

Transaction Class Labor

Project 11500

CastVariation
Resource PA
Quartity 10

Chargeable

Notes

—  Approve | Reject [ Cancel

Transattion Date 12/20/2000

Client Clientis

Project Site New Yark

CostCode Deliver

Rate 10.00 §USD
Amount 100,00 $LSD

Transaction Date 1/10/2001
Transaction Class Labor
Client Client1s
Projest J1500
Praject Site New Yark
Cost Code Deliver
CostVariation
Resnurce Jaquish, Matt
Quartity 10
Rate 10.00 $USD
Amount 100,00 $USD
Chargeable ™

Motes This was transferred because blah blah blah yada

vada yada

The following table describes the items that appear on the Details Page

for Transferred Transaction.

Iltem

Approve

Reject

Cancel

Transaction Date
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Description

Approves a WIP Adjustment transaction. See
“How to Approve a WIP Adjustment” on
page 58.

Rejects a WIP Adjustment transaction. See
“How to Reject a WIP Adjustment” on page 58.

Cancels the action and returns to the WIP
Adjustment Page.




Item

Transaction Class

Description

Transactions are organized into classes:

¢ Labor

¢ Materials

¢ Equipment

* Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

Client The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project Grouping of all services (work) and goods to
be provided for a given job.

Project Site

Cost Code The services being performed or items being

used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

¢ Material

*  Equipment
+ Expense

There is no limit to the number that can be
defined.

Cost Variation

Resource

Quantity

Rate

Amount

Chargeable A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.

Notes
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How to Approve a WIP Adjustment
To approve a WIP Adjustment:
1 Review the information on the Details Page.
2 Click <Approve>.
3 The WIP Adjustment is approved.

4 The Approve WIP Adjustment Page appears and the WIP
Adjustment is removed from the Results section.

How to Reject a WIP Adjustment
To reject a WIP Adjustment:
1 Review the information on the Details Page.
2 Click <Reject>.
3 The WIP Adjustment is rejected.

4 The Approve WIP Adjustment Page appears and the WIP
Adjustment is removed from the Results section.
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Details Page (Reversed Transaction)

The Details Page displays WIP Adjustments that have been submitted
for approval.

To view the Details Page from the Approve WIP Adjustment Page, click
the <Date> Link next to the Adjustment Type in the Results section that
you want to view.

Niku Confidential

Work » Financial Processing » Approve WIP Adjustment » Details

Reversed Transaction

— Reject | | Cancel

Transaction Date  12/19/2000
Transaction Class Labar

Client Customer 1000
Projest 11500
Project Site Londan
GCostCode Deliver
Costvariation
Resource P
PO Number 12345
Quantity &
Rate 27500 §USD
Amount 2750.00 $USD
Chargeahle [@
onsite ¥

Notes This was reversed because blah blah blah.
s Approve | Reject | | Gancel

ik

The following table describes the items that appear on the Details Page
for Reversed Transaction.

Item Description

Approve Approves a WIP Adjustment transaction. See
“How to Approve a WIP Adjustment” on
page 61.

Reject Rejects a WIP Adjustment transaction. See

“How to Reject a WIP Adjustment” on page 61.

Cancel Cancels the action and returns to the WIP
Adjustment Page.

Transaction Date
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Item

Transaction Class

Client

Project

Project Site

Description

Transactions are organized into classes:
¢ Labor

¢ Materials
¢ Equipment
¢ Expense

The Class field provides an identifier to the
system to control how to process a given
transaction. The user can define as many
Transaction Types as required, for a given
Transaction Class.

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Grouping of all services (work) and goods to
be provided for a given job.

Cost Code

The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢ Labor

¢ Material
¢+ Equipment
¢ Expense

There is no limit to the number that can be
defined.

Cost Variation

Resource
PO Number
Quantity

Rate

Amount

Chargeable
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A transaction representing costs (labor,
material, equipment, or expense) that may be
billed to a client.



Item Description

On Site Indicates that the work was performed at the

client’s location.

Notes

How to Approve a WIP Adjustment

To approve a WIP Adjustment:

1

2

3

4

Review the information on the Details Page.
Click <Approve>.
The WIP Adjustment is approved.

The Approve WIP Adjustment Page appears and the WIP
Adjustment is removed from the Results section.

How to Reject a WIP Adjustment

To reject a WIP Adjustment:

1

2

Review the information on the Details Page.
Click <Reject>.
The WIP Adjustment is rejected.

The Approve WIP Adjustment Page appears and the WIP
Adjustment is removed from the Results section.
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AR Integration

This chapter describes Accounts Receivable (AR) Integration. This
chapter includes the following information:

¢+ “About AR Integration” on page 64

+ “AR Integration Page” on page 66
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About AR Integration

Posting to AR transfers invoice and credit memo information
originating in Niku 6 to the AR module. Niku 6 assigns the next
available invoice and credit memo number based on the AR setup
definition for assigning numbers. Standard invoice prefixes begin with
the designation of I, followed by a sequential number then the three-
digit entity code. Standard credit memo prefixes begin with the
designation of C, followed by a sequential number then the three-digit
entity code.

In the example below, the Niku 6 generated invoice has an invoice
number of 10000000205-COA. This invoice is the first page of the
document and is a summary. Detail pages can be optionally attached to
the Niku 6 invoice to provide a detailed description of billing items,
including the resource providing the work by date if required by the
client or project.

Plegse remi pavmeant o
onsultants OF Amenca INVOICE Invoice 4 000000205 COA
"aate
Buite

Date: D219

Page: 1

Alicis Darsge Docrs
9 Eacina

Pine Bush, NY 12566
USA

RE: Rendered gervices and/or meurred expenses 120198 through 12/1098

Praject Tutal
Hew Prochact Launch $16,000.00
Frapect Tatal §16,000.00
Tex $1,12000
Total Balance Dwue: £17.120.00
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A credit memo will not be available to post to AR until the associated
invoice has been posted in Acuity AR. A sample credit memo follows.
Note that the Niku 6 document designation (similar to the invoice) is

included on the credit memo.

Chegit Mamo issved by
Forsultants Of Amenca CREDIT MEMO

Credat Memo # CODODDO0206-COA

00 TriState Date: 04/21/%9
fHuits 100
Lincolnshire, IL S0060 Fage: 1
[UNITED STATES
KB4T) 9458100
Alicis Jarage Docrs
9 Encina
Fine Bush, WY 12566
USA
Credat Memo was isswed for ervoice #I0000000205.C0A
R
Praject Tetal
New Praduct Launch $16,000.00
Credit Memo Tatal: $16,000.00
Tax $1,12000
Tatal Credit Memo $17.120.00
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AR Integration Page

The AR Integration Page enables you to search for and post an invoice
or credit memo to accounts receivable.

To view the AR Integration Page from the Home Page, under Work click
Financial Processing » AR Integration.

To view the AR Integration Page from the Work Page, under Financial
Processing click the <AR Integration> Link.

To view the AR Integration Page from the Financial Processing Page,
click the <AR Integration> Link.

H > o

Niku ik o &7 %
Work » Financial Processing * AR Integration

Search

EFostTyoe [Credit Memos = Enlity [uADISON Browse

~— Search Clear | Cancel

Results

& Invoice Number Client Code Entity

™ CrMODOOD13 CLIENT10 MaDISON

+—+ Post

B = Required
©2001, Niku Corparation. 14} : 43 @ : 2 (4

The following table describes the items that appear on the AR
Integration Page.

Item Description

Search Locates and displays results based on Post
Type and Entity. The search results appear in
the Results section on the AR Integration
Page. See “How to Search for an Invoice/
Credit Memo” on page 67.

Clear Clears the search attribute fields.

Cancel Cancels the action and returns to the Financial
Processing Page.
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Item Description

Post Posts an Invoice/Credit Memo. See “How to

Post to AR” on page 67.

Browse (link) Browse for an object or set of objects to

include in the filtering criteria.

Post Type Invoice or Credit Memo.

Entity

Invoice No

Client Code The Client Code is a unique identifier for the

client. Every client must have a Client Code

How to Search for an Invoice/Credit Memo

To do a Search:

1

In the Search section on the AR Integration Page, select the Post
Type (Invoices or Credit Memo) and Entity (specific Entity or All).

Note: The entity displayed on the AR Integration Page is
determined by the client’s location assignment. When the post is
performed, the entity displayed should agree with 3-digit entity
designation on document.

Click <Search>.

The search results appear in the Results section on the AR
Integration Page.

How to Post to AR

To postto AR:

1

Do a search. See “How to Search for an Invoice/Credit Memo” on
page 67.

In the Results section of the AR Integration Page, select the Invoice/
Credit Memo you want to post by clicking in the checkbox.

Click on <Post>.
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4 The Invoice/Credit Memo is posted to AR.
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Estimates To Complete
(ETC) Processing

This chapter describes Estimates To Complete (ETC) Processing. This
chapter includes the following information:

+ “About Estimates To Complete (ETC) Processing” on page 70
+ “Estimates To Complete Page” on page 71

¢ “Edit Estimates To Complete Page” on page 73
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About Estimates To Complete (ETC) Processing

The RM-PM Link is the current integration between the project plan and
the project accounting modules. The project plan collects ETCs and
actuals. The relationship between the Budget, Actuals and ETCs is an
intricate one.

A project plan starts out with a total effort required to complete a job. At
this point only estimates exist. As a result, total effort is equal to the
estimates. Assuming the effort is constant, the estimates for a project are
reduced by the actuals that entered the project plan.

If an ETC is increased, then the total effort for a project is increased. In
the project accounting module, the sum of Actuals and ETC is used as
another basis for Percentage of Completion (POC) revenue recognition.
This allows the financial budget to be independent of total effort
required to complete a project.

Changes to the project plan due to changes in actuals and ETCs are
passed to project accounting as the basis for a budget revision. The
accountant does not always want to update a financial budget due to an
increase in total effort required to complete a project. The reason is that
the accountant wants to measure the variance between the financial
budget and the project plan. Using ETCs in conjunction with the budget
allows the accountant to measure that variance.
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Estimates To Complete Page

The Estimates To Complete Page enables you to search for projects to
review the Estimates to Complete.

To view the Estimates To Complete Page from the Home Page, under
Work click Financial Processing » Estimates To Complete.

To view the Estimates To Complete Page from the Work Page, under
Financial Processing click the <Estimates To Complete> Link.

To view the Estimates To Complete Page from the Financial Processing
Page, click the <Estimates To Complete> Link.

AT e n Niku Confidential 7%

Work » Financial Pr To C:

pl

Search

Glient Location Browse Project Code Browse
Client Gade Browse

— clear || Cancel

Results

Client Name Project Name

Acme Company Year 2000 Conversion

Revision

0
RuppmMan Group ERP Implementation

Ruppman Group ERP Selection

User Interfaces “Web Development

0
1
o

The following table describes the items that appear on the Estimates To
Complete Page.

Item Description

Search Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Estimates To Complete Page.
See “How to Search for a Transaction” on
page 72.

Clear Clears the search attribute fields.
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Item Description

Cancel Cancels the action and returns to the Financial
Processing Page.

Browse (link) Browse for an object or set of objects to
include in the filtering criteria.

Client Location Each Client has at least one Location, but
each Client may have multiple Locations.
Usually refers to the various physical locations
at which an Client performs business.

Client Code The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project Code The Project Code is an identifier for the
project. Each project must have a Project
Code.

Client Name The name of the client.

Project Name The name of the project.

Revision The current budget revision for this project.

How to Search for a Transaction
To do a Search:

1 Inthe Search section on the Estimates To Complete Page, enter any
of the search criteria.

2 Click <Search>.

3 The search results appear in the Results section on the Estimates To
Complete Page.
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Edit Estimates To Complete Page

The Edit Estimates To Complete Page enables you to adjust the Estimate
To Complete and to save or submit the change.

To view the Edit Estimates To Complete Page from the Home Page,
under Work click Financial Processing » Estimates To Complete. Enter
in the search criteria and click <Search>. Click on the <Client Name>
Link.

To view the Edit Estimates To Complete Page from the Work Page,
under Financial Processing click the <Estimates To Complete> Link.
Enter in the search criteria and click <Search>. Click on the <Client
Name> Link.

Niku m .ﬁ @ pni Niku Confidential RS
Work » Financial Pr To Complete » Edit Estimates To Comp
Glient Caterpillar Tractor Company
Project ERP Customization
— [Bave] | submit | | cancel
CostCode Variation Employee Actual Hours Hours Budgeted Budget Remaining Current Estimate Estimate To Complete Outiook Variance
DELIVER David Brenner -a7 300 357 0o =57 -357
DELIVER Edward Albee 234 S00 266 300 200 934 24
DELIVER Frank Gifford 243 280 37 37 |37 280 o
DELIVER Guy Forsythe 200 200 100 100 [100 300 o
DELIVER Melly Fortada 313 400 87 87 [B7 400 o
DELIVER Peter Hicks 1083 1100 17 17 |17 1100 o
DELIVER Robert Downey aze 500 172 172 |172 500 o
DELIVER Sally struthers 283 400 17 17 17 400 o
DELIVER Tony Danza 377 300 77 77|77 300 o
~—+ Save | Submit Cancel
@ 2001, Niku

The following table describes the items that appear on the Edit Estimates
To Complete Page.
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Iltem

Save

Description

Saves the change to the Edit Estimates To
Complete Page without submitting. See “How
to Save an ETC Edit” on page 75.

Submit

Saves and submits an ETC edit. See “How to
Submit an ETC Edit” on page 75.

Cancel

Cancels the action and returns to the Estimate
To Complete Page.

Client

The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project

Grouping of all services (work) and goods to
be provided for a given job.

Cost Code

Variation

Employee

Actual Hours

Hours Budgeted

Budget Remaining

Current Estimate

Estimate To Complete
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The services being performed or items being
used to complete a given project. Cost Codes
fall into one of four transaction classes:

¢+ Labor

¢ Material
¢  Equipment
¢ Expense

There is no limit to the number that can be
defined.

Individuals who enter time spent on performing
their respective services for one or multiple
projects.

The actual hours worked on this task.

The amount of hours that were budgeted to
work on this task.

The remaining budget after Actual Hours are
subtracted from the Hours Budgeted.

The current estimate of hours necessary to
complete this task.

The user’s estimate of the hours needed to
complete this task.



Item Description

Outlook The sum of the Current Estimate and Actual
Hours.

Variance The Current Estimate less the Budget
Remaining.

How to Save an ETC Edit
To save an ETC Edit:
1 Make the appropriate change in the Estimate To Complete Field.
2 Click <Save>.

3 The change is saved, but not submitted.

How to Submit an ETC Edit
To submit an ETC Edit:
1 Make the appropriate change in the Estimate To Complete Field.
2 Click <Submit>.

3 The change is submitted and the Estimate To Complete Page
appears.
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Revenue Recognition

This chapter describes Revenue Recognition. This chapter includes the
following information:

¢+ “About Revenue Recognition” on page 78
¢+ “Revenue Recognition Page” on page 80

+ “Revenue Recognition Worksheet Page” on page 83
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About Revenue Recognition

Financial Management offers the capability to recognize revenue on a
percentage of complete (POC) basis. For certain types of projects,
primarily long-term contracts and retainers, this method of revenue
recognition is required. Financial Management POC generates and
records transactions that can be posted to the General Ledger for
revenue recognition on projects where POC is appropriate. The revenue
recognition transactions typically affect revenue and deferred revenue
categories of General Ledger accounts. The following rules apply to
POC Revenue Recognition:

¢ POC can only be used with budgeted contract or retainer projects.

+ Financial Management’s POC processing feature allows revenue
recognition to be based on either the project’s contract or budget
amount. This selection is specified in Financial Management’s
Processing menu in Application in the System Administrator. If an
entity has some projects that use POC based on contract and some
projects that use POC based on budget, both options may be
enabled. If both options are enabled, the choice of method is made
at the project level during setup.

+ For projects that use the Contract Method, the only required
input on the budget header screen is labor hours. All other
budget entries are optional. When using the contract amount as
the basis of revenue recognition, the total amount of revenue to
be recognized for a project will EQUAL the amount of the
contract for that project. When a project is setup, the value of the
contract must be allocated by transaction class - labor,
equipment, materials and expenses. This is done in the
Contracts tab in Project Setup.

+ For projects that use the Budget Method budgets are assigned at
the “Category” level for Expense and either at the “Category” or
line item level for Labor, Materials and Equipment. When using
the budget amount as the basis of revenue recognition, the total
amount of revenue to be recognized for a project will EQUAL
the sum of the four transaction classes - labor, equipment,
materials and expenses from the budget header. The
“Contingency” and Administrative Fees fields in the budget
header will not be used in the calculation.
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For material and equipment POC transactions, the dollar amount
incurred will equate to Cost + Mark-Up + Burden + Overhead.

Budget revisions are supported.

The Financial Management POC processing feature does not allow
use of milestones as a basis of revenue recognition.
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Revenue Recognition Page

The Revenue Recognition Page enables you to search for, view and
submit transactions.

To view the Revenue Recognition Page from the Home Page, under
Work click Financial Processing » Revenue Recognition.

To view the Revenue Recognition Page the Work Page, under Financial
Processing click the <Revenue Recognition> Link.

To view the Revenue Recognition Page the Financial Processing Page,
click the <Revenue Recognition> Link.

ﬁ} "é @ ﬁ Niku Confidential

Work » Financial Pr

Search
Client Code Browse WIP Class Browse
Client hiame Browse POC Method [Budget and Contract =
Project Code Browse E1Transaction Cut-off Date

ProjectName [ | Browse
~» [Bearch | | ctear | | Cancel

Override Transaction Date Option

Enter an Override Date or leave blank to use today's date

Override Transaction Date

Results

& ciient Code Client Name Praject Code Project Name POC Method Total to Recognize Remarks
CL19446

W | S Company A P1234567 Project A Contract 10,000.00 d

I CLa6743 Company B P4567890 Project B Budgst 10,000.00 b

I cLe4657 Company C P7890123 Project C Budget 10,000,00 ac

I cL713470 Company D P0123456 Project D Contract 10,000.00

I cLsosos Company E P3456780 Project E Budget 10,000.00 d

B = Required

2= Actuals are overbudget

b = Revenue is over-recognized

& = Unapproved budget exists

d = Unapproved work-in-process adjustment exists

— | Subimit

i) Mt k@ [

The following table describes the items that appear on the Revenue
Recognition Page.
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Item Description

Search Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Revenue Recognition Page.
See “How to Search for a Transaction” on
page 82.

Clear Clears the search attribute fields.

Cancel Cancels the action and returns to the Financial
Processing Page.

Submit Submits a transaction. See “How to Submit a

Transaction (Without Viewing)” on page 82.

Browse (link)

Browse for an object or set of objects to
include in the filtering criteria.

Client Code The Client Code is a unique identifier for the
client. Every client must have a Client Code
Client Name The name of the client.

Project Code

The Project Code is an identifier for the
project. Each project must have a Project
Code.

Project Name

The name of the project.

WIP Class

Total to Recognize

Primarily used for financial reporting of
projects. WIP Class is used as a means of
grouping Work In Process transactions for the
General Ledger.

Transaction Cut-off
Date

Override Transaction

Date

POC Method

Remarks
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How to Search for a Transaction

To do a Search:

1

In the Search section on the Revenue Recognition Page, enter any of
the search criteria.

Click <Search>.

The search results appear in the Results section on the Revenue
Recognition Page.

How to Submit a Transaction (Without Viewing)

To submit a transaction without viewing:

1

2

Do a search. See “How to Search for a Transaction” on page 82.

In the Override Transaction Date Option section, enter the Override
Transaction Date

In the Results section, click the checkbox next to the Client Code of
the transaction that you want to submit.

Click <Submit>.

How to View a Transaction

To view a transaction:

1

2

Do a search. See “How to Search for a Transaction” on page 82.

In the Results section, click the <Client Code> Link of the
transaction that you want to view.

The Worksheet Page appears. See “Revenue Recognition Worksheet
Page” on page 83.
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Revenue Recognition Worksheet Page

The Revenue Recognition Worksheet Page enables you to search for,
view and submit transactions.

To view the Revenue Recognition Worksheet Page from the Revenue
Recognition Page, click the <Client Code> Link under the Results
section of the invoice that is to be viewed.

Niku iEeé o Niku Confidential 57 %

Work Pr Revenue i Worksheet

Transactions to 12/20/2000

~+ [Bave] _submit | Resaiouiats | | Giear | | Gancel

Client Code: 1234, Client Name: Niku, Project Code: .J554, Project Name: Financial Screens, POC Method: Internal

Contract/Budget Actuals

Previously  Amount to
Category Amount (SUSD) Hours Amount ($USD) Hours i ize (3USD) Amount to ize (SUSD)  Remarks
Lty 172,700.00 960 25,620.00 7005 oon  [126,017.03 126,017.03  d
Materials 98,000,00 400 34,00000 2305 oon  [13,500.50 1350050 &
Equipment 98,000.00 400 34,000.00 2305 oo [13,500.50 13,500.50
Expenses 98,000.00 400 34,000.00 230.5 oon 1350050 13,500.50
Project Total 166,518.53 166,518.53

Override Transaction Date Option

Enter an Override Date or leave blank to use today's date.

Overtide Transaction Date

a = actuals are overbudget

b = Revenue is over-recognized

¢ = Unapproved budget exists

d = Unapproved work-in-process adjustment exists

—+ Bave [ Submit Recalculate Clear | Cancel

The following table describes the items that appear on the Worksheet
Page.
Item Description

Submit Saves and submits the worksheet. See “How
to Submit a Transaction” on page 84.

Cancel Cancels the action and returns to the Revenue
Recognition Page.
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How to Submit a Transaction
To submit a transaction:
1 Enter an Override Transaction Date.
2 Click <Submit>.

3 The transaction is submitted and the Revenue Recognition Page
appears.
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Transaction Archive

This chapter describes Transaction Archive. This chapter includes the
following information:

¢ “About Transaction Archive” on page 86
+ “Transaction Archive Page” on page 87

+  “Preview Transaction Window” on page 90
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About Transaction Archive

In order to optimize performance, customers need the ability to archive
projects. The user may designate how often the company wants the
transactions to be archived when creating a project. Project transactions
can be archived automatically at the end of the project, a prompt can
suggest archiving at the end of the project, or the user can select when to
archive the project transactions. The users also need a method to access
records that have been archived.

Prior to archiving transactions, the project or change order must be
closed. All relevant processing must be complete for a project before it
can be closed. For example, a non-internal project cannot be closed until
all amounts in WIP are billed, matched or adjusted.
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Transaction Archive Page

The Transaction Archive Page enables you to search for, archive, restore

or preview transactions.

To view the Transaction Archive Page from the Home Page, under Work

click Financial Processing » Transaction Archive.

To view the Transaction Archive Page from the Work Page, under
Financial Processing click the <Transaction Archive> Link.

To view the Transaction Archive Page from the Financial Processing

Page, click the <Transaction Archive> Link.

Niku fiee n &%

Work » Financial Pr ion Archive

Search

Location I_CH]cAGO Browse Project Browse

Client [ prowse Stalus [available to archive =]
- _Bearon | Clear || Gancel
Results
Selections will be executed on a scheduled basis.
& Client Project Entity Location
—+  Archive

ation) i & @ : i [

The following table describes the items that appear on the Transaction

Archive Page.

Item Description

Search Locates and displays results based on
information entered in search attribute fields.
The search results appear in the Results
section on the Transaction Archive Page. See
“How to Search for a Transaction” on page 88.

Clear Clears the search attribute fields.

Cancel Cancels the action and returns to the Financial

Processing Page.
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Item Description

Archive Archives a transaction. See “How to Archive a
Transaction (Without Previewing)” on page 89.

Restore Restores a transaction. See “How to Restore a
Transaction (Without Previewing)” on page 89.

Browse (link) Browse for an object or set of objects to
include in the filtering criteria.

Location Each Client has at least one Location, but
each Client may have multiple Locations.
Usually refers to the various physical locations
at which an Client performs business.

Client The Client Code is a unique identifier for the
client. Every client must have a Client Code

Project Grouping of all services (work) and goods to
be provided for a given job.

Status

Entity

How to Search for a Transaction
To do a Search:

1 Inthe Search section on the Transaction Archive Page, enter any of
the search criteria.

2 Inthe Status drop down box, choose “Available to Archive” or
“Awvailable to Restore”.

3 Click <Search>.

4 The search results appear in the Results section on the Transaction
Archive Page.
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How to Archive a Transaction (Without Previewing)

To archive a transaction:

1

3

Complete a search for a transaction to include the Status being
selected for “Available to Archive”. See “How to Search for a
Transaction” on page 88.

Click the <Radio Button> in the Results section for the transaction
you want to archive.

Note: Only one transaction at a time may be archived.

Click <Archive>.

How to Restore a Transaction (Without Previewing)

To restore a transaction:

1

3

Complete a search for a transaction to include the Status being
selected for “Available to Restore”. See “How to Search for a
Transaction” on page 88.

Click the <Radio Button> in the Results section for the transaction
you want to restore.

Note: Only one transaction at a time may be restored.

Click <Restore>.

How to Preview a Transaction

To preview a transaction:

1

Complete a search for a transaction to include the appropriate
Status. See “How to Search for a Transaction” on page 88.

In the Results section of the Transaction Archive Page, click on the
link in the Project column for the transaction you want to view.

The Preview Transaction pop-up window displays. See “Preview
Transaction Window” on page 90.
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Preview Transaction Window

The Preview Transaction Window enables you to view information on a
transaction prior to archiving or restoring that transaction.

To view the Preview Transaction window from the Transaction Archive
Page, search for a transaction, select one of the transactions in the
Results section, and click <Preview>.

Niku Niku Confidential ?

Preview Transactions to Archive

u Content of page TED; targeted feature complete date in June. |

Labor 4
Material 7
Equipment 12
Expense 0O
Total 23

+ Close

© 2001, Niku Carp

The following table describes the items that appear on the Preview
Transaction Window.

Item Description
Close Closes the window.
Archive Archives a transaction. See “How to Archive a

Transaction” on page 91.

Restore Restores a transaction. See “How to Restore a
Transaction” on page 91.

Labor

Material

Equipment

Expense

Total
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How to Archive a Transaction
To archive a transaction:
1 Review the information on the Preview Transaction Window.

2 Click <Archive>.

How to Restore a Transaction
To restore a transaction:
1 Review the information on the Preview Transaction Window.

2 Click <Restore>.
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10

Niku GL Integration

This chapter describes General Ledger (GL) Integration. This chapter

includes the following information:

*

“About Niku GL Integration” on page 94

“GL Integration Window” on page 96

“Examples of GL Distribution” on page 97

“GL Column Hierarchy” on page 105

“Define/Modify GL Distribution Rules” on page 108

“Post to GL Process” on page 116

“GL Reporting” on page 120
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About Niku GL Integration

Seamless integration to third-party financial systems can be achieved by
using Niku General Ledger (GL) Distributor. Niku GL Integration
features Niku Corporation’s powerful matrix technology offering users
the ability to post transactions from Niku to a third-party’s GL through
user-assigned business rules, or generate reports used to create a
manual journal entry in any financial package.

Niku integration to a GL module allows users to collect information for
ongoing internal and client projects, and post transactions in summary
from Niku to the GL. Transaction information available to be posted
includes time, revenue, expenses, adjustments and costs.

Niku GL Integration has the ability to define the business rules,
including exceptions, which determine how transaction information is
grouped, analyzed and posted to the GL. Niku GL Integration provides
the necessary flexibility to accommodate the GL account structure
created for any company.

Niku GL Integration selects the appropriate GL account number by
matching the information in a transaction to a two-part GL Distribution
Rule Set. The first part selects the best match for the GL Hierarchy, while
the second part identifies the GL accounts that post to GL.

The GL Column Hierarchy is typically performed by the user’s company
Financial Reporting Manager. It is a one-time setup. The Hierarchy is
where classifications for transactions are assigned for the company. The
Definitions are generally cross-referenced to the segments defined
within the company’s Chart of Accounts. GL integration with Niku can
be based on a variety of factors. These factors include WIP Class, Project
Class, Employee Class, Cost Code, Location and Department.

The second step is to define the Distribution Rules. These rules associate
the GL account numbers, for which transactions will be generated, to the
business processing rules in Niku.

The third step is the Post to GL. This process generates entries in the

proper format for processing by the GL module. Users can specify which
transactions are to be posted, or can select to have all transactions posted
in a single session. All items posted to GL are posted in summary by GL
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account. This eliminates maintaining detail in both Niku and financial
packages. Access to the supporting detail is available on request
through Niku, allowing Niku to be a subsidiary ledger to the GL.

Reports can be selected at various points of the above processes. The
user can also define customized reports to supply information unique to
their processing needs. Reports can include information involving
which items have been posted, are waiting to be posted, GL account
number assignments for selected postings, and error listings of accounts
not yet selected for posting.

Niku GL Integration posts to the GL on an entity basis (i.e., company)
and supports integration with multiple GL databases for a single Niku
database.
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GL Integration Window

To view the GL Integration Window from the Home Page, under Work
click Financial Processing » GL Integration.

To view the GL Integration Window from the Work Page, under
Financial Processing, click the <GL Integration> Link.

To view the GL Integration Window from the Financial Processing Page,
click the <GL Integration> Link.

Niku Confidential

GL Integration

To install GL Integration, click on the link below and follow the
instructions:

http: fw-rmrudinsky/Gladiator/changes/install.exe

[

The following table describes the items that appear on the GL
Integration Window.
Item Description

Install GL Integration Click on the link to install GL Integration and
Link follow the on-screen instructions.

Close Closes the GL Integration Window.
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Examples of GL Distribution

The following examples are presented to provide a quick feel for what is
happens when rules are used to post transactions to the GL. More detail
and specific procedures involving the GL hierarchy and distribution
rules will follow this section.

Example 1:

The GL distributions for a transaction type are represented below.

The table assumes a hierarchy of Location (Level 1), Department (Level
2) and Client Class (Level 3). The Transactions table below (Table B)
provides examples of transactions in WIP. The Distribution column in
this table indicates which GL Distribution in the GL Distribution Table
(Table A) would be used to post the transaction.

Table A: GL Distribution Table

Distribution Location Department Client Class
(Level 1) (Level 2) (Level 3)

1 New York Sales Large Co.

2 New York Tax Large Co.

3 New York Tax *

4 New York * Large Co.

5 New York * Small Co.

6 New York *

Table B: Transactions

Transaction Location Department Client Class Distribution
A New York Sales Large Co. 1
B New York Sales Small Co. 5
C New York Tax Large Co. 2
D New York Tax Small Co. 3
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Table B: Transactions

Transaction Location Department Client Class Distribution
E New York Consulting Medium Co. 6
F Detroit Tax Small Co. None

The following is an analysis of proper distributions based on the
distribution rules and sample transactions provided in the tables above
in Example 1:

+ Transaction A meets the criteria of Distribution 1, 4 and 6.
Distribution 1 is an exact match of all columns, and therefore is
chosen as the distribution. The exact match of Department overrides
the wildcard match of Distribution 4. Distribution 6 is not as specific
as Distribution 1, so Distribution 6 is not used for this transaction.

+ Transaction B meets the criteria for distribution 5 and 6. Distribution
5 is chosen because it is more specific than Distribution 6, as the
Location and Client Class are exact matches.

+ Transaction C meets the criteria for Distribution 2, 3, 4 and 6.
Distribution 2 is chosen for the distribution because it is an exact
match on all three columns. The exact match of Client Class
overrides the wildcard match of distribution 3. Distribution 4 is not
as specific as Distribution 2, so Distribution 4 is not used for this
transaction.

+ Transaction D meets the criteria for distribution 3, 5 and 6.
Distribution 3 is chosen over Distribution 5 because the exact match
on Department is at a higher level of the hierarchy than that of the
exact match on Client Class. Distribution 6 is less specific than 3 and
5, therefore it is ruled out.

¢ Transaction E meets the criteria of Distribution 6 only so is it used.

¢ Transaction F does not meet the criteria of any of the distribution.
Therefore, it would show up on edit report as a transaction that
cannot be posted.

Note: A specific module will override the * selector when matching
distributions.
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Example 2:

In addition to the transaction type and column hierarchy, the
Chargeable Status and Project Type also determines matches between
WIP transactions and the GL distribution. The GL Distribution form
allows users to select whether they wish a distribution to apply to a
chargeable transaction, non-chargeable transaction, internal project
transaction or non-internal project transaction.

Table C displays a list of GL distributions for a Transaction Type of
Labor and a column hierarchy of Entity. The table also displays WIP
distributions and the GL Distribution that would apply to each record

Table C: Labor Distributions

Distribution Transtype Entity Chrg Non-Chrg Int Non-Int

1 LABOR * on on

2 LABOR * on on

3 LABOR * on on

Transaction Transtype Entity Chrg ProjType Distribution
A LABOR NY YES INTERNAL

B LABOR NY YES STANDARD

C LABOR NY NO INTERNAL

D LABOR NY NO STANDARD NONE

The following is an analysis of proper distributions based on the
distribution rules and sample transactions provided in Table C of
example 2:

Transaction A is chargeable and has an internal project type. Therefore,
it matches GL distribution 3.

Transaction B is chargeable and has a standard project type (non-
internal). Therefore, it matches GL distribution 1.

Transaction C is non-chargeable and has an internal project type.
Therefore, it matches GL distribution 2.

Niku 6 Financial Processing User’s Guide

99



Transaction D is chargeable and has a standard project type. There is no
GL distribution set up for that combination. During a trail run this
transaction would appear on the GL Exceptions report as unmatched.
During an actual post, if the Name and Options selection “GL Flag No
Match Do Not Post” is off, the transaction would appear on the GL
Exceptions report as an exception. If the Name and Options selection
“GL Flag No Match Do Not Post” is on during an actual post, the
transactions would be flagged as Do Not Post. Do Not Post transactions
are picked up for future GL posting sessions.

Example 3:

The default GL distribution for every transaction type defined for labor,
materials, equipment and expenses consists of all Niku columns
populated with the wildcard. The account number is populated with the
debit and credit accounts defined for default entity. The percent (%)
field defaults to 100 for the debit and credit entries. The source fields for
the debit and credit defaults to “Total.” The Post to GL option should be
checked if the default entity defined in Name and Options has the
manual posting method checked. The Post to GL option always defaults
off for the system-defined transtypes (e.g., ADJUST< DRMEMO...).

| | fntity [Ext] Accounthumber [Percenf  Source | Debit | Chg |Non-Chlinternal] Honnt. |
" [~ |1015-00-00-00 100.000 Total Smourt ¥ r ¥ v Il
|| al* [ 25000000 [10000Totadmt | [ | [ | M | P [ [ ]
3 I L] I 2000 O A

The GL distribution for the Credit Memo, Adjustment, Debit Memo
Voucher Adjustment and Matching Reversal transaction types contain
an additional option (Reverse Original) on the GL Distributions form. If
the Reverse Original Transaction option is selected, then any transaction
with a transaction type of Adjustment, Matching Reversal, Debit Memo,
Voucher Adjustment or Credit Memo that meets the column hierarchy
can be distributed using the original transaction’s GL control records.

The debit lines change to credits, and the credit lines change to debits
prior to GL distribution. This provides a reversal of the original entry.
When the Reverse Original box is selected, any account information set
up in the GL Account Distribution section is overridden. Multiple
distributions can be defined for the Adjustment, Matching Reversals,
Debit Memo, Voucher Adjustment and Credit Memo transaction types.
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The user is capable of defining reversing distributions and non-
reversing distributions within the Credit Memo and Adjustment
transaction types.

The default distribution for Adjustments, Matching Reversals, Debit
Memos, Voucher Adjustments or Credit Memos will have both the Post
to GL and Reverse Original options off. The column hierarchy fields
default to the wildcard (All). The Entity, Account Number, Percentage,
Source, Debit, and Credit fields are disabled because they are not
applicable if Post to GL is unchecked. The user can add more GL
distributions or modify the default distribution.

The reversing of original transactions for Adjustments, Matching
Reversals, Debit Memos, Voucher Adjustments and Credit Memos may
have a performance impact on GL posting. Checking the column
hierarchy will occur two times - once to find the adjustment class GL
distribution and another time to find the GL distribution for the original
transaction.

Example 4.

Niku GL Integration ensures the debits equal the credits (e.g., total is
debited, amount and factor are credited or total debited and total is
credited). Checks also are provided to make sure percentages are used
consistently. The Valid Rule Types for Applying Percentages table
below (Table D) shows the rules required for validating distribution
percentages. Burden, Overhead, Total, Amount, Factor, Total Cost and
AP Total Cost are percentages in Table D, and the sigma (?) of these
fields is the summation of the percentages and not the summary of the
values.

Table D shows the valid combinations of the source fields. Each source
can be subdivided, provided that the percentages meet the rules
outlined in the table. Warning messages will be displayed when the
defined rules are violated.
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Table D: Valid Rule Types for Applying Percentages

Debit Credit

Total Total

Total Amount + Factor
Mark-up Mark-up

Bur + OH + Amt +Ftr Total

Bur + OH + Amt +Ftr

Bur + OH + Amt +Ftr

Total Cost Total Cost
APtotalcost APtotalcost
Tax Tax

Factor Factor
Burden Burden
Overhead Overhead
Amount Amount

Rule
ZTotal = ZTotal

ZTotal = ZAmount +
ZFactor

Mark-up = ZMark-up

ZBur + ZOH + ZAmt +
Ftr=2Ttl

ZBur + ZOH + ZAmt +
>Ftr = *Bur + *OH +
ZAmt + ZFtr

ZTotalcost = ZTotalcost

ZAPtotalcost =
ZAPtotalcost

*Tax = 2Tax
*Factor = ZFactor
*Burden = *Burden
*OH = *OH

ZAmount = ZAmount

The rules for applying percentages are applied to an Entity. A
distribution between companies must have the debits and credits of
company A balance and the debits and credits of company B balance.
The Table E below illustrates how all the rules in Table D are applied on
an Entity/Company basis.

Table E: How Debits and Credits Apply to Entities

Entity % Source Debit Credit
Company A 60 Total X
Company B 10 Total X
Company C 30 Total X
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Table E: How Debits and Credits Apply to Entities

Entity % Source Debit Credit
Company A 60 Total X
Company B 10 Total X
Company C 30 Total X
Company C 30 Amount X

Company C 30 Factor X

Company C 30 Total X

The Percentage field can also be used for inter-department distributions.
See the Inter-Department Distribution table below (Table F) for an
example of how inter-department distributions can be implemented.
The rules in Table D still apply to inter-departmental distributions. The
columns in the hierarchy can determine when an inter-department
distribution should be used.

Table G: Posting Costs to the GL

Account# % Source Debit Credit
123-dept A 60 Total Cost X

123-dept B 40 Total Cost X

456-dept A 60 Total Cost X
456-dept B 40 Total Cost X
321-dept A 100 APtotalcost X

654-dept A 100 APtotalcost X
123-dept A 100 Total X

456-dept A 100 Amount X
456-dept A 100 Burden X
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Table G: Posting Costs to the GL

Account# % Source Debit Credit
789-dept A 100 Factor X
789-dept A 100 OH X

Table G: Posting Costs to the GL

Account# % Source Debit Credit
123-dept A 60 Total Cost X

123-dept B 40 Total Cost X

456-dept A 60 Total Cost X
456-dept B 40 Total Cost X
321-dept A 100 APtotalcost X

654-dept A 100 APtotalcost X
123-dept A 100 Total X

456-dept A 100 Amount X
456-dept A 100 Burden X
789-dept A 100 Factor X
789-dept A 100 OH X

The transaction type definition determines if and how a transaction in
the WIP table is to be posted to GL. The transaction type defines how the
GL account is to be selected from the information contained in the WIP
record. The user has the flexibility to define multiple transaction types
for the transaction classes of labor, equipment, materials, and expenses.

The user can define multiple transaction types that have a transaction
class of Labor. The user must map cost codes to the desired transaction
type. Each of the transaction types defined with a transaction class of
Labor can be posted using a different set of criteria. The transaction
classes of Adjustments, Billing, Write-Ups and Write-Downs can only be
mapped to a single transaction type. These transaction classes are
internal to Niku, so the user has less flexibility with them.
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GL Column Hierarchy

The GL Column Hierarchy establishes the first level of qualification
criteria, at which transactions are evaluated for GL posting. This
qualification is provided through the Hierarchy by defining the columns
of a user-defined rules matrix, whereby each transaction is a row of the
matrix that is evaluated against the columns.

The Column Hierarchy can be used to allocate revenue or cost
transaction types to the company’s departments or regions. Up to six
Columns can be defined in the Hierarchy. It is not required to use all of
the Columns for the complete hierarchy definition. Wildcard defaults
can be assigned to any of the Columns to establish general rules
requiring that only exceptions be keyed. The columns of Entity,
Location, Department, Client Class and Cost Code were defined in the
example below.

[ fle Edt Search Frocess Miew Hepots Opfions Window Hep =121
Jb‘l.-! sRB|TE QmE | &2w
TrxType | Source Module  [Post] | Entity | Location | | Class| Cost Code |E
DRMEMO ARG . . g g
» T T O O O N
= cLo q 5 A *
i ol o T T g g
- Il s
- Ol O g
| C| [ | | | =l
| Entity |Ext| Account Humber [Percent{  Source | Debit | Chg |Hon-Ch|internal Hon-int. |
% | m 100.00 [ [ m| [m] F
L
|Fo Help, press F1 [NUM |
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How to Work with GL Column Hierarchy Definition

1 From the Start menu, select Programs » Niku » Niku GL

Integration.

The Niku GL Integration Login screen appears.

2 Enter a User ID and Password in the Login screen.

The Niku GL Integration dialog box appears.

3 From the Edit menu, select GL Column Hierarchy. The GL Column

Hierarchy Definition dialog box appears.

Gl Column Higtachy Definition

fiwalsbls for Selection

L Cokamn Hisserchy |

Lberi Lass

Cost Class

Cogl Coche

Clepuartmmend

E mphogas Class h
Endly L
Location

o Clars

W mmation

WP Clas

I |
=i

4 Move the Column Headings listed in the Available For Selection box
into the GL Column Hierarchy box by highlighting the desired
fields (in predefined sort order), and clicking the right movement
arrow button. If an incorrect selection is made, highlight the item in
the GL Column Hierarchy box and click the left movement arrow

button.

ol Ladume Hiedaichy Detinibing

givaiabls for Selection

Losl Llats
Employee Class
Progecd Clacs

o gration

WP Class

-0
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5 Continue column assignments until there are up to six column
headings listed.

6 Review column order and verify that the desired hierarchy is
defined. To relocate an item in the hierarchy, highlight the item and
click on the up or down arrow to move the item.

7 Click <OK> to save the Hierarchy definition.

Note: Contact a Niku Consultant if there are any questions
regarding the available selections.
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Define/Modify GL Distribution Rules

GL Distribution Rules define the specific qualification and association of
each class of transaction tracked by Niku. For example, a retainer bill
may need to be posted to a different GL account than an invoice for a
standard hourly project. Depending on how the hierarchy is defined, if
the billing transaction has a location of “ABC” it may be posted to a
different GL account than a similar billing transaction with a location of
“DEF”. Up to six columns can be assigned, so a large number of
transaction qualification combinations are available.

Niku allows the use of a wildcard (*) in columns, where applicable. This
allows a user company to easily define general rules and detail only the
exceptions to the rules, which minimizes setup entry. An example
would be two companies with identical revenue account definition. A
wildcard could be used in the Entity column and the one definition
would apply to relevant transactions for both companies.

Each transaction type (e.g. time, costs, expense, billings) within Niku
can have its own set of rules determining how transactions are posted to
the GL. Each transaction has all the information required to post the
transaction to the appropriate account. Additionally, transactions can be
allocated via a percentage across multiple accounts. This allows, for
example, three accounts (relating to WIP) to be debited with the offset
entry going to a single credit account (Deferred Revenue).

The forms for defining Distribution Rules can be accessed directly from
the Niku GL Integration module.

How to Define/Modify the Distribution Rules

1 From the Start menu, select Programs » Niku » Niku GL
Integration.

2 The Niku GL Integration Login screen appears.
3 Enter a User ID and Password in the Login screen.

4 The Niku GL Integration dialog box appears.
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From the File menu, select Open. The GL Distributions form
appears.

[ fle Edt Search Frocess Miew Hepots Opfions Window Hep =121
Jb‘l.-! sRB|TE QmE | &2w
TrxType | Source Module  [Post] | Entity | Location | | Class| Cost Code |E
DRMEMO ARG . . g g
» T T O O O N
= cLo q 5 A *
| [Nl =i g
- Il s
- Ol O g
| C| [ | | | =l
| Entity |Ext| Account Humber [Percent{  Source | Debit | Chg |Hon-Ch|internal Hon-int. |
% | m 100.00 [ [ m| [m] F
L
|Fo Help, press F1 [NUM |

Review the list of GL Distributions on the top half of the form and
click in an existing row of rules to modify a rule, or in a new row to

define a new rule.

Click in each field to define/modify Distribution Rules using the
following field definitions:

*

Trx Type: click on the Lookup icon on the toolbar to select
from the Transaction Types list. The Transaction Type is the
key field for the Distribution Rules Set. Distributions are
defined for each Transaction using the GL Column
Hierarchy, which must be defined prior to defining
Distribution Rules. Transaction Types are created in Niku.
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Trx Type Lookup [ %]

Enter Search Text
VOLUCHAD
Trxz Type | Description =
ADJUST WP Adjustment
BILL Project Invoices
CONTRACT FixdilFes Bil

COSTS
CRMEMO
DRMEMO
EXPENSES
FEES
INTERNAL
MATCHING

3rd Party Costs
Credit Memo

Debit Memo

Cut Of Pocket Expenses
|Conzulting Fees

Interral Fees

Maching

MATCHREY

Match Reverse

RETAINER

o ]

Fetainer Biling

Cancel |

Note: Distribution Rules may be defined without selecting the Post
option. These distributions will not post until the Post option is

enabled.

¢ Source Module: click on the Source Module list, and then select
Source Module. Specifying a Source Module provides the
ability to define the GL Distribution of a transaction based on
the module where it originated. Valid module selections are
Project Accounting, Integrator, and Either (represented by the
(*) option). Use the (*) option is if the source module is of no
significance to the user. The Integrator option is only available
for Transaction Types that may originate in the financial system
(e.g., adjustment, debit memo, etc.).

Tra Ty | i b
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110 Niku 6 Financial Processing User’s Guide

wwwn| bty | st b |

i ol



Post: select box to enable or disable the Post function. If selected,
the Post function will allow the transaction to be posted to the
GL Database and activate the lower part of the form where
additional fields identified later are entered.

L
TSI

s Aocouniing

T | (P hewas| Bty | nsiaes | | ttinist] i Lok ]
ST T F 0 0 g g g

il |

T
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o
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Reverse: select box to distribute certain transactions using the
original transaction GL control records. This option can be used
for Adjustment, Matching Reversal, Debit Memo, Voucher
Adjustment or Credit Memo transaction types that match the
GL Column Hierarchy. The debit lines are changed to credits
and vice versa prior to distribution to the GL. This provides a
reversal of the original entry. Some combinations of transaction
types and source modules will cause the Reverse option to
appear inactive.

GL Hierarchy Parameter: enter the appropriate values based on
definitions set up in the GL Column Hierarchy. Enter an asterisk
(*) as a wildcard parameter to accept any value.

Bl Calumm Higdaichy Dafinikion

Bvalabls for Selecton GL Cioharn Hissenchy [ .
Leri Liass E nibily
Cost Class Location Carcel I
Dt Cosl Cocle
E mplogsse Clasz WIF Class
Paogact Clagze I + I
W ainlon L,
B +]

Note: Fields labeled “Entity” through “Non Int” are used in
conjunction with the transaction type and GL Column Hierarchy to
determine matches between WIP transactions and the GL
distributions.
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+ Entity: click the Lookup icon on the toolbar to select an Entity
from the Entity Lookup list. The selection will determine which
database GL Integration posts to. Only entities with the GL
Interface Posting Method set to Manual are on the list.

Entity Lookup E |

Enter Search Text

i

Entity Hame
O, [Consuitsnts OF America
S0, Systems of America

ok | Cancel |
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Select the wildcard (*) from the list to indicate use of the Entity
defined in the WIP Transaction Table. Use the wildcard if the
Chart of Accounts is the same for all Entities. Otherwise, to
accommodate differences in the Chart of Accounts, rules must
be defined for each Entity, with a different account number for
any given Transaction Class.

Entity Lookup E3

, Enter Search Text:

i

;C::unsurtaﬂts Of America
So8  [SystemsofAmerica

Ext: select to activate or deactivate the use of the External GL
Account. If activated, all reversals of prior GL postings will use
the GL Account posted by the external accounting system.

Account Number: click the Lookup icon on the toolbar to
activate a zoom into the Chart of Accounts. Select an account
number for the Distribution.

|Post| Bewerse|  Entity | Loeation | Cost Cete |
=3 = rra FHACETEFRTERRR. |

| Enter Seanch Teet:
GLAzenin | Dttty [l
131 0-[0- (000 Fragund Fiurshcs J
e | R
B I oA 1000 feed
R 1520.00.00:00  [Lsassholel iprvements

1525-I0- 0000 Accurn D . Lsassnokl Bnpaoesments
1530-00-D0-00 [Wiarehouse Equpnent

15205 - [ Anciurn Depr - Warehouse Exupaent
1SE0-I0-D0-D0 | veicies

L3 [SE w0000 [Accunbe - vee
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¢ Percent: click in the field, and then enter the transaction percent
that is being posted to the selected account.

¢ Source: click the Lookup icon on the toolbar to select a source
field in the WIP record used in posting for the dollar amount
(e.g. Total). Other valid source fields are Amount, Factor, Total
Cost, AP Total Cost, Burden, and Overhead and Mark-up. The
transaction type determines which source fields are available.
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+ Debit: select to determine if the distribution will be posted as a
debit, or posted as a credit.

¢ Chg: select to activate, or clear to deactivate the chargeable
attribute. If activated, Niku will recognize the transaction as
applying to a chargeable transaction.

+ Non-Ch: select to activate, or clear to deactivate the non-
chargeable attribute. If activated, Niku will recognize the
transaction as applying to a non-chargeable transaction.
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+ Internal: select to activate, or clear to deactivate the internal
attribute. If activated, Niku will recognize the transaction as
applying to an internal project effort.

1

Il | Centity [Ext] Account Humber [Percend  Source | Debit | Chg [Won-Chlinternal] Hon-nt, |
0 [ 1015000000 [100000|Total&mourt | @ | [ | @ | [ r

|| fl* [ [2035000000  [100000 Totsldmort | [ | [ | W | M [ [_|
[E3 | 100001 vV C [V

¢ Non-Int: select to activate, or clear to deactivate the non-internal
attribute. If activated, Niku will recognize the transaction as
applying to an external project effort.

Create a new row and complete fields on lower part of form for each
credit or additional debit entry using definitions above.

Note: The debits and credits must balance or the distributions will
not save, when the Post option is selected.

Save and close form when all rows have been defined.

Note: Notall posting items are relevant to all integrations (i.e., Debit
Memos).
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Post to GL Process

Niku GL Integration generates entries in the proper format for
processing by the GL module. The user can identify filters for the
selection of transactions to be processed including WIP Entity, Location
and Department, WIP Start and End Dates, and Transaction Types. Only
those transaction types with rules defined in the GL Distributions Rules
are processed. The user has the option of performing a Trial Run, which
can be reviewed for accuracy before posting the transactions to the GL.
Transactions having errors will not post. These transactions will be
listed in the GL Exception Report. A prompt will allow the user to
request the report during the Trial Run or GL Posting.

How to Post to GL

1 From the Process menu, select GL Post. The Post To The General
Ledger form appears.

Fost To The General Ledges
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2 From the Criteria group lists, select Entity, Location and
Department.
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3 From the Dates group lists, select Start Date, End Date and GL
Posting Period.
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Note: The posting period date defaults to the ending date of the
current period date defined in the GL database to which the selected
entity is mapped.

4 Select a Posting Mode group option.

Note: The Trial Run Only option is recommended to create a report
so as to view the transactions prior to Posting. If doing an Actual
Post, enable or disable a “Confirm Post” prompt by clicking the
Disable Confirm Post Prompt option. If disabling the prompt,
transactions will automatically Post to GL without notifying the
user of errors or providing the option to cancel the posting.
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5 Click the Posting Count button. A count of Transactions to be posted
appears.
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6 Click the Post button to view or post the transactions selected. The
Transaction Generation Recap dialog box appears.

Transaction Generation Recap |

P 22 Transactions Posted
c 35 Transactions Are In Eror
0 Transactions Did Not Post

Would You Like To Continue?

J No |

7 Select <Yes> to continue to either generate the Trial Run report or
post the transactions. If the Trial Run was selected, the Trial Run
report will be generated and a prompt for the Exceptions Report
appears. If Actual Post was selected, a message will display
verifying the posting completed and a prompt to generate the
Exceptions Report appears.
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Posting Complete |
| }, Posting Process Complete

- “would Y'ou Like To Run
The Eda=ptions Report?

No

8 Select <Yes> to generate the report, or <No> to finish processing.

Note: A warning message displays after all selections are made and
the user clicks the Post button. The message asks the user to
continue with the Post or cancel the Post without change. This
warning can be disabled by selecting the Disable Confirm Post
Prompt option located on the Posting form.

Niku 6 Financial Processing User’s Guide 119



GL Reporting

Through Niku GL Integration, a variety of reports can be generated to
identify the flow of transactions between Niku and the GL. A brief
description of each report follows.

GL Distributions Report

The GL Distributions Report is a detailed list of all defined distributions.
This report can be generated from the Niku GL Integration Reports

menu.
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GL Posting Review Report -Trial Run

The GL Posting Review Report - Trial Run is generated when the Trial
Run option is selected from the post processing. This reports is a
detailed listing of the transactions selected for posting, including
identifying the journal type and GL account number. Generating the
trial run provides a tool for reviewing transactions for accuracy before
the items are posted to GL.
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GL Posting Review/Exceptions Report

The posting process allows the user to generate a combined GL Posting
Review/Exceptions Report from the posting process. The report has two
parts. The first part, GL Posting Review, displays each item of a
transaction selected for posting that posted successfully. The second
part, GL Exceptions Report, displays each item of a transaction selected
for posting that did not post and identifies the reason the transaction
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failed to post. Examples of exceptions preventing posting are no
distribution setup, invalid GL account number, and debits do not equal

credits.
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11 Niku Financial Integrations

This chapter describes Financial Integrations. This chapter includes the
following information:

+ “About Niku Financial Integrations” on page 124
+ “Financial Integrations Window” on page 125

+  “Niku Financial Integrations Setup” on page 126
¢ “Purchase Orders” on page 147

+ “Accounts Payable” on page 152

+ “Inventory” on page 155

+  “Process Engine” on page 156
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About Niku Financial Integrations

Niku Financial Integrations provides the same user interface when
distributing costs to projects in Niku, whether accessed through an
Accounts Payable (AP), Inventory (IV), or Purchase Order (PO) module,
or directly. Niku Financial Integrations performs the tasks of
distributing costs, generating reports and posting distributions by
client, project, cost code, and employee from the third-party module to
Revenue Niku.

The Niku Financial Integrations functions are identical whether you’re
distributing a vendor voucher in an AP module, an inventory issue in an
IV module, or assigning a PO module to one or more projects. The
following is a walk-through of Niku Financial Integrations
functionality. After this walk-through, a detailed description of AP, 1V,
and PO module processing is provided.
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Financial Integrations Window

To view the Financial Integrations Window from the Home Page, under
Work click Financial Processing » Financial Integration.

To view the Financial Integrations Window from the Work Page, under
Financial Processing click the <Financial Integration> Link.

To view the Financial Integrations Window from the Financial
Processing Page, click the <Financial Integration> Link.

Niku Confidential

Financial Integrations

To install Financial Integrations, click on the link below and follow the
instructions:

hittn:/ fw -mrudinsky fGladiator/changes install.exe

©2001, Niku Corporation

The following table describes the items that appear on the Financial
Integrations Window.

Item Description

Install Financial Click on the link to install Financial Integrations
Integrations Window Window and follow the on-screen instructions.
Link

Close Closes the Financial Integrations Window.

Niku 6 Financial Processing User’s Guide 125



Niku Financial Integrations Setup

Niku Financial Integrations requires an initial setup that is a one-time
process. There are two access methods available for ongoing use of the
Niku Financial Integrations:

¢ The first and most common method to access Niku Financial
Integrations is by clicking the Niku Financial Integrations icon while
in an inventory issue, voucher or PO entry form. This will launch
Niku Financial Integrations and allows for the line items on the
document to be distributed to clients and projects at the point of
initial entry.

¢ The second method is to directly access the Niku Financial
Integrations application and process the distributions. This method
is used when document assignment and posting of distributions are
to be performed in batch.

The functions of the Niku Financial Integrations apply to the third-party
AP, IV, and PO modules. They include;

¢ “Niku Financial Integrations One-Time Setup” on page 126
¢ “Other Setup Options” on page 131

¢+ “Document Selection” on page 133

¢ “Posting Distributions” on page 138

+ “Generating Vouchers from Expense Reports” on page 141

¢+ “Reporting” on page 153

Niku Financial Integrations One-Time Setup

Before items can be processed using the Niku Financial Integrations, the
setup needs to be completed. When Niku Financial Integrations is
accessed directly from a third-party document, a default User ID of PAl
is assigned to control the security rights of the user. Niku Financial
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Integrations cannot be launched from third-party documents if the
default user is not defined. If internal security guidelines require
limitations to user rights, the default needs to be defined within those
guidelines in Niku. Normally, access would not be granted to the
Posting and Process Engine menu options to AP, IV and PO clerks. The
following procedure includes steps that are normally performed by a
System Administrator.

How to Set Up Niku Financial Integrations

1 From the Start menu, select Programs » Niku » Niku Financial
Integrations and the Niku Financial Integrations Login screen
appears.

2 Click the Servers button and the Server Alias Maintenance dialog
box appears.
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3 Click the ODBC button and the ODBC Data Source Administrator
form appears.

F100BC Data Source Administratos

Uset DEN | System DSN | File DSH | DDBC Detvees | Tracha | About |
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Note: Be sure the server name is listed in the User Data Source
section and is properly configured. If not, click the Add button and
complete the setup before configuring Niku Financial Integrations
to run on the server.

4  Click <OK> to exit and return to the Server Alias Maintenance
dialog box.
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5 Click the Aliases button and the Alias Maintenance form appears.

Aliaz Maintenance [x]
—&fiag Selection————————  — Alias Atibutes———
Show Drivess IUDEE TI Data Set Hame Browse..
ined i | chigzzgl01

Logm D
|ga
Pagsword

™ Prgmpt For Lagin Information

ok | cencel |  Mew | Dewe | [ies |

6 Select a defined Alias, or click the New button and the New Alias
form appears.

7 Enter the Alias Name and verify the Driver Type is ODBC on the
New Alias form.

Note: The Alias name must be the same as the Server name.

8 Click <OK> to return to the Alias Maintenance form.
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9 Highlight the defined Alias and click the Test button to verify the
connection to the database. A Connection Successful message will

appear.
Alias Maintenance x|
—Alag Selecton————————————  — flias Atibwtes—————————
Show Drivess IUDHE TI [iata Set Hame Browse...

Connection Test E
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ok | cancel |  Mew | Deme | Tew |

10 Enter the Data Set Name, Login ID, and Password of the Server.

11 Click <OK> to close the message and <OK> on the Alias
Maintenance form to return to the Database Setup dialog box.

Database Setup |
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12 From the drop-down boxes, select Alias, Database, SQL Statement
Alias, and SQL Statements Table and click <OK>. The Niku
Financial Integrations Login screen appears.

13 Enter User ID and Password, click <OK> and the Niku Financial
Integrations Menu screen appears.

Other Setup Options

Other setup options which may require attention are identified in the
following “How To” procedure.

How to Work with Other Setup Options

Mapping Defaults

1 From the Options menu in Niku Financial Integrations, select
Mapping Defaults and the SQL Mapping Defaults dialog box

appears.
Compary | Apply I
Congsultants OF America _:I
Delete

[ﬂndl.ie 4'
I.-’-'-.cu:u:nmts FPapable ;I Clgze
| Default Akas Aliases...
|CHIDASOLD3 =l
| Defaul Database

2 From the drop-down lists, select Company, Module, Default Alias
and Default Database.

3 Click the Apply button.
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4 Continue setting up all combinations of Modules and Companies
relevant to processing requirements.

5 Click Close and return to the Niku Financial Integrations Menu
screen.

SQL Statement Mappings

1 If you have set up the mapping defaults, as described above, this
mapping is already pre-loaded into the integration and requires no
action on the part of the user. It is included as reference document if
a condition occurs that may require its use.

2 From the Options menu of Niku Financial Integrations, select SQL
Statement Mappings and the SQL Statement Mappings dialog box

appears.
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3 Verify the assignment of each defined Company to the selected
Module, Document Type, SQL Statement, Database and Alias.

4 This step is especially important if the modules are on different
databases.

5 Click <OK> and return to the Niku Financial Integrations Menu
screen.
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Document Selection

This option only applies if the user wants to launch Niku Financial
Integrations outside of the AP, IV or PO document. Other than the initial
Open Document form, the application functions are identical as when
accessed from integrated AP or PO modules.

How to Work with Document Selection

1 From the Start menu, select Programs » Niku » Niku Financial
Integrations and the Niku Financial Integrations Login screen

appears.

2 Enter User ID and Password.

3 Click the <OK> and the Niku Financial Integrations Menu screen

appears.

4 From the File menu, select Open and the Open Document form

appears.
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5 Select Company, Module Type, and Document Type, and one of the

following options:

¢ Open Unposted Documents

+ Posted Documents
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+ All Documents

A list of documents matching your selection criteria will appear in
the bottom portion of the Open Document form.

Note: If no Companies have been setup, or if the connection has not
been defined properly, you will receive an error message that no
Companies have been set up. Refer to the Integrator Other Setup
Options section above for detail on mapping defaults.

Mo companies have been setup in
Options...S0L Statement Mappings yetl

“vou must do this first before you
can select a company.

6 Highlight the appropriate document and click <OK> or double-
click on a document and the Integrator Header form appears.
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Using the Default button you can assign a document to a Client,
Project, Cost Code and automatically apply all line items to that

default.

*
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8

10

+ Ifavoucher applies to multiple clients, projects, cost codes or
employees then the assignments can be performed for each line
as required.

¢ Optionally, a line item can be split across multiple Client,
Project, Cost Code and Employee distributions.

Click the Defaults button to distribute a default client/project/cost
code to all line items and the Distribution form appears.

Distrbutons - [em: Defoks]

Aty ¥
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Select the Client, Project, Cost Code, Variation and Employee to be
defined as defaults and click <OK>. If no prior distributions exist for
this document, a prompt will offer to allocate all items to default
distribution.

Question

[ ":? Da you wish to allocate all of the
details to this default distibution?

Click <Yes> to distribute the costs to the default. The costs will be
distributed as defined and the Niku Financial Integrations Menu
screen appears.

Click <No>, if you do not wish to distribute, and you will return to
the Niku Financial Integrations Menu screen.
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11 Click the Distributions Lookup button on a line item and the
Distributions form appeatrs.

12 Click the Client Lookup button and a list of clients with active
projects will appear.

| Mldebaran, Inc ALDEBAR

Aldiebaran, Inc ALDEBAM
Alicia Garage Doors ALICLE

13 Highlight the appropriate client, click <OK> and return to the
Distributions form.

14 Click the Project Lookup button and a list of projects for the selected
client will appear.

15 Highlight the appropriate project, click <OK> and return to the
Distributions form.

Note: Once the client/project is selected, the location and
department fields will be filled in using the project’s location/
department. These default values may be changed to pull a rate or a
budgeted cost code from another location/department.

16 Click the Cost Code Lookup button and a list of available cost codes
will appear.
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17

18

19

20

21

22

23

24

Highlight the appropriate Cost Code (and variation, if applicable),
click <OK> and return to the Distributions form.
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Click the Employee Lookup button to select a chargeable employee
and a list of employees will appear. If no employee is selected, the
default employee is used.

Highlight the appropriate employee, click <OK> and return to the
Distributions form.

Enter a quantity and the amount to be distributed will be allocated
based on the quantity and actual cost.

Note: The quantity to be distributed is based on the definition in the
financial system. A dozen is treated as a single unit, not 12 units.

Click the project Site Lookup button, if applicable, and a list of valid
project sites appears.

Highlight the appropriate Site, click <OK> and return to the
Distributions form.

Enter a Trans Date to assign the transaction a date. If no date is
specified, the document date will be used as the Niku transaction
date.

Repeat steps above until all amounts have been distributed.

Note: You may not distribute a quantity or an amount that is greater
than the line item you are distributing. However, if the Niku Setup,
Name & Option Allow Partial Distributions to Post option is ON,
distributions less than the line item can be posted. To mark up the
AP cost, you must define the appropriate Cost Plus or Cost Code
Multiplier Rules in Niku. Refer to the Transaction Assignments
chapter for instructions on defining mark-up rules.
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Posting Distributions

Once a document has been saved and posted in the third-party module,
the distributions can be posted to Niku. Posting can be filtered by
company, module, document type and date range. A Trial Run can be
performed before posting the distributions. Once posting of
distributions is complete, the transactions generated are available for
posting to WIP in Niku.

Under the Process tab form in Niku Setup there is an option to Allow
Partial Distributions to Post. If selected, Niku Financial Integrations will
allow the user to post distributions of a document that has not been fully
distributed. Once the distributions are posted, the items not previously
distributed cannot be distributed. When the Trial Run or Post
distributions is executed, a warning will be displayed notifying the user
that the item has not been fully distributed. If the box is not selected, the
Trial Run will return an error message that the document has not been
fully distributed. When the Post is selected, this item will not post. Refer
to Setup for instructions on implementing.

How to Post Distributions

1 From the Start menu, select Programs » Niku » Niku Financial
Integrations and the Niku Financial Integrations Login screen
appears.

2 Enter User ID and Password and click <OK>. The Niku Financial
Integrations Menu screen appears.
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3 From the Process menu, select Post Distributions and the Post
Distributions Range Selection form appears.

Pazl Distibubione Range Selechion

+ Data Fibes Rarges
From Compang Ta Compay
Consubants O Amenca EI Consularts Of Ameica EI
From Modue | Ta Moguls
Acounts Panabhs EI I-hu:-:tl.ﬂ'- Fayabin EI
Ficen Dourent Tope | Ta Domumert Type
e EI I'r'n:u.hau B]
|FI'G-EWJT-FIE'¢M |Tnlﬁw0ﬁ
[Em s =] [was =]

w Corcel |

Note: If changes were not saved prior to accessing Post
Distributions Range Selection form, a prompt to save appears. Click
<Yes> to save.

Question R

YYou must save your changes before
you can post or do a trial run!

Do you want to save them now?

4 Select the following filters using the appropriate Lookup buttons:

*

From and To Company
From and To Module
From and To Document Type

From and To Document Date
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5 Click <OK> and the Post Distributions Summary dialog box

appears. The items selected for posting will be recapped on this

form.

[Rost Distibutions Summary £
A~ ot @ Liisl Fur ok | cancel |

Company Module Dooumert Type  Doouments
El:.(.rs-ll.y'tr. DF Arngnca ;A::.-: oLty Papable |'-."|:-|:.h¢| | 2|

6 Select action by clicking the Trial Run or Post option.

Note: It is suggested that the user execute the Trial Run feature to

generate a report to view the transactions prior to posting.

7 Click <OK> to either generate the Trial Run report or post the

distributions. A prompt will display recapping the results of the

Trial Run.

Quesztion E |

@ The trial run is complete!

3 documents had no exceptions and
1 documents had exceptions.

Do you want ta run the Posting Fesults report
for more information?

] w |
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8 Click <Yes> to generate the Posting Results report or to post
distributions, or <No> to return to the Post Distributions Range
Selection form.

:\E) Do wou want to run the P& Posting Results/E xceptions report’?

3

Note: If there are posting exceptions, a prompt will ask if you would
like to generate the PA Posting Results/Exceptions Report.

Generating Vouchers from Expense Reports

The Process Engine is a tool used to generate an AP voucher from
expense report transactions. While in Niku Financial Integrations, it is
accessed from the Process menu and it operates in single-user mode.
Only one user at a time may process transactions.

Niku provides two methods of processing the client/project
distributions of expense report costs. The first method involves
processing the distributions through the Niku Time and Expense
modules (the default method), while the second method involves
processing the distributions through Accounts Payable (AP). While on
the Process tab of the Name & Options form in Niku Setup, clicking
Allow Flow Through to AP enables the second method. The process
flow of the two methods is as follows:

Allow Flow Through to AP disabled (the default setting):

The default for the flow of client/project distribution of expense report
costs is through the Niku Time and Expense modules. The client/project
distributions defined through the cost keys of the expense report
generate transactions for processing billings. These transactions are
posted to WIP and are then available for billing or matching. Since an
expense report cannot be modified after it has been submitted, a change
to a voucher requires a manual WIP adjustment to effect the change.
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Allow Flow Through to AP enabled:

With this option enabled, the client/project distributions of expense
report costs flow into Niku through AP. These distributions or the
payable amounts can be modified in AP prior to the voucher being
posted, thus eliminating the need for a manual WIP adjustment for a
modification to a voucher.

The Process Selector dialog box allows selection of the Export T&E
Expense Report to AP option. In addition to the Last Executed On date
provided next to the Process Name, selection of History button provides
an execution listing. The process Execution History provides the date,
time and user each time the process has been performed. Select the
Export T&E Expense Report to AP option and click <OK>.

PocossSoootor &
Process Name | Last Executed On | 0K |
E zport Payroll Infarmation 07/28/99 5:.02 PM
Export THE Expense Reports To AP 07/23/39 2.47 PM Cancel
Import External Transactions 07/28/39 5:.02 PM
Irport Payroll Actual Costs 07/28/33 5.03 PM

< | i

Description

This process will export ATE expense reports to AP, creating one voucher per expense
report, and one detail line item per expense type. A valid vendor code must be defined
in the P& employee table for each employee whose expense report is to be exported.

The Expense Report Data Selection form appears. Select appropriate
criteria and select <OK> to generate AP vouchers for expense
reimbursement. The export function uses the employee’s location/
department for filter criteria.
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The export function uses the employee’s location/department for filter
criteria.

Expense Report Data Selection x|

— Data Filter Ranges

‘Locdim |CHIEAGD QITlj |IF|\-"INE Sl LI

‘D.eputrrm IADMIN QITn ICHEAT 3'
‘Emplwee I fl Sl

‘Dgle |u4mwsa Z|| To |u4329;99 E|

FurrStock Item default by Acuity company setup

| Company Hame | Itemn Description
Consultants Of America ‘Project Accounting Expense
Systems of America ___{Project Acoounting Expense |

For an employee’s expense reports to be available for posting to AP
several setup steps must be performed. The employee must be assigned
a location, whose entity has Active selected for the AP interface record.
The vendor code selected in Niku Employees must be a valid vendor in
the company AP module, and the employee’s entity/location
combination must match the third-party module company associated
with the vendor code.

The Export T&E Expense Report to AP option generates one voucher for
each expense report. The voucher has one line item for each collection of
transactions by expense type. For example, if three transactions for the
expense type Airfare are entered in expense entry then one line item for
Airfare (which summarizes the airfare items) is generated on the
voucher.
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When exporting transactions, no status bar will appear on the screen.
The hour glass changes back to a cursor when your processing is
complete. If an error is encountered during processing, the entire batch
of transactions being submitted is returned as “not processed” until the
error is corrected.

Export ATE Expense Reports To AP Progress E

| Current Action | Process Expense Reports

Description | Pracess Expense Reports...
Action Type | Retrieving...

Only expense reports that have been submitted to Niku from within the
Niku Time and Expenses modules are available for posting to AP.
Additionally, the Check No field in the Reimbursement tab of the
Expense Report Details form in Time & Expense must be blank for an
expense report to be available for posting. For expense reports already
reimbursed, either change the status to Paid or through Expense Report
Details, enter a check number on the Reimbursement tab.
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After the posting process is complete, a Process Results window will
provide a summary of the posting results. Additional processing
information can be viewed in the Return Message portion of the form by
highlighting the desired row.

Enliy ‘Wouchers Created

Kl 1]

Retumn Message

Mo Emor =
[

Reporting

Niku provides three standard reports as well as the ability to launch
customized reports from within Niku Financial Integrations. The
Distributions Report allows filtering of information presented by
company and module with the option to include posted distributions
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matching the selected criteria. Information is displayed by company,
module and document (e.g. voucher number) and reflects the status of
the distribution in the Niku Financial Integrations table.

Frived DGI0SM1999 250 M Distibutions Faport Paga 2of 4
) . Companies from * 32 sezszzasss
By PoulAlars Mackies fam " 1o mmisnn
Compary Code: Campeey Name: ek o Araica |
Mokt
Voucher  Type Stes  Cient Project  CostCode Varision Employes  Dets Site  Chrg Ouanity  Fale Amoun
OO D Foswd DAWSON  ALOIT oTHERREC wn wmAEE ERT=T #0500
COD00000CE: DaWSON  ALOIT OTHERREC CHIACTT s ] HEANN0 $12150.00
QAWSON  ALDIT OTHERREC CHTACT! (8158 M nsEs0 13100
ey BAWSON  ALEIT HRAEC  TRIALCON Rl A 1 oo 50000
O AiCh FEO OTHERREC i 519 1 aamon £30m
MG PRI alkERREC [ s 1 asn 52500
0000003 STOTTORD VK TEST  EQUP Hil 0N o s #040m
oo Alce MED atkERRc ik s 1\ 13300
OO0 vl MDA GO QTHERREC [ A a 0 40000
CAMPEELL  MABEDD  OTHERREC [ s W smas 5%
0000000032 DAWSON  ALIDIT OTHERREC Lo AN 40 00 $8.000.00
DAWSON  ALEIT aTkERREC um s ERE-T $71.563
0000000033 Posted  ALICW PLOOT CONTRALT KK AR 5 15845 7925
Vouchar Tatal T
Module Tatal w7 mam
i
Purchese ( Type Stetus  Clent FPraject Cost Code  Vansion Employee Dt Site Chrg Cusantty Rate Amourt
OO el Hew  CAMPSELL  FOSO01 OTHERREC [ [T 5 womon =0m0m
Freight CAMPBELL  POSOO COURIER [ Hul 08 #1000 150.00
Detsd BLACK  MABEDO|  OTHERFEC Yk ol 5 $10m00 =00m
Feigtt BLACK  MAGEON  OTHEAREC Kk Hut 08 pmo 1500
OO Dmted QAWSON  ALEIT OTHERREC B 5Nz 1 R5MES 55465
O MELSON  SOTATEST  OTHERREC o i 1 12300
SO000C000E; AICR MG QTHERREC Eil Mt N w00 58000100
CAMPEELL  MABEDM  OTHERREC Kl Hut W s 15,5345
000000007 DawSON  ALDIT OTHERREC. ot TR ASA 40 20000 . $8000.00.

The Committed Costs Report displays the Niku distributions of open
Purchase Orders. An example is included in the Purchase Order section
of this chapter.

The Posting Results selection displays the results of the last execution of
the PA Distributions processing. The Valid Distribution section of the
report displays the transactions that posted successfully. The Posting
Exceptions section lists details for transactions that failed to post and
provides a description of the error(s).

Frinted: 42193 1208FM Posting Exceptions Feport Page 2ol 2
By Poul Aters Trinl P gacegtians ¥om Apr 11388 120620 937FM
Company D i ] Company Name: [ ]
Module: fecori: Pasbis
Vaucher  Twme Chiart Froiect  CostCode Veriton Emploves  Ste  EmarMessaae
O3S Deted DHWEON  ALOIT DTHERAEE WAKIN: The doctamven was nal found i the crigraing spstem
DawsON AL0IT DTHERAELC WARNING: The decusenl wat nel lound i the oignating spdemn
BLACK.  FLOOI DTHERAEC WARKING: The docisrsant wat nol forsd i the rigrfing sysdem
BLACK  FLOM DTHEFAEL WARIKING: The dociment was ot foured i the rigrating epsten
UNITED  CONTRACT  DTHERAEC WRINING: The decumsnt was ol found i the crigrating system
LMITED COMTRACT DOTHERAELC WIRRNING: The decusiend wai nod lound i the igeating spsten
Fusight DEWSIN  ALDIT DTHERAEC WARKING, Tha docurmen wat nol foured it crigrfing sysdem
BLACK FLOOM DTHERAEC WIFIRING: The document was nol found in e orignating spstem
UMITED  CONTRALT DTHERAEC WARINING: Tre document was nol found in the crignafing spstem
T DewSON ALOIT OTHERAEL WIRANING: The docusent wa nol found i the geating spstem
BLACK. FLOM DTHERAEL WARNING: Tha decusan wat nel found i the oignating syden
LMITED  CONTRACT DTHERAEC WIFIKING: The document was nol found in e orignating spstem
D000 Dted WITED  CONTRWCT  DTHERAEC WARIHING: Tre decument was not foured in e origrating spstem
Woucher Exceptians it
Madue Exceptians 13
Company Excegtians: 3
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Purchase Orders

Purchase Orders (POs) are requests for items that may be related to
projects tracked in Niku. These costs are not definite costs, therefore, the
amounts are not posted to Niku. They must, however, be considered in
monitoring the costs committed to a project. Niku provides these costs
to be distributed to projects in the PO module. These distributed costs
can be viewed in the Committed Costs Report. When AP vouchers are
generated from the PO, the distributions transfer to the voucher. After
the voucher has been generated, PO distributions will no longer appear
in the Committed Cost Report. This section includes:

¢ Distributing PO Costs
¢+ Committed Costs Report

¢ Processing PO

Distributing PO Costs

A PO entered in a third-party module must be saved before the costs can
be distributed in Niku. Niku Financial Integrations is used to transfer
PO information from the third-party module to projects in Niku. The
Niku Financial Integrations is accessed via the Project Accounting icon
on the toolbar of the Enter Purchase Orders form. PO costs can be
distributed at the line item level to multiple Client/Project
combinations. For ease of entry, defaults can be set up to distribute all
amounts to one Client/Project for a particular PO.
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ﬂFnter Purchase Orders

~a| o8| #| Sl@ | & 2]
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[0000000235 ] Change Orde([Froject Acoouniing CulShith]  Status

|Un|ssued 'l
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Hesder | LineDefauls | Lines | Ioss |
Company ICGA ﬂ whee | Sl Diepartment I g Status IElpen 'l
o | q |
Oty Ord Oty Open UoM Unit Cost Ordered Amount
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Custom Feids... | HEquiTe Rereit = =
U I
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How to Work with PO Distributions

1 Select the appropriate PO while on the Enter Purchase Orders form.

2 Click the Integrator button and the Niku Financial Integrations
Menu screen appears.

[J Fe Bl Y Progwes Bepath Opkors Windee Heb =zl
rEE S M R

W _
I'l_ulc--.ll | o Ui k'] 110 FLB00 F1LIE 0 W
FREIGHT |Ussrerisebmata| 1 [y [T W |
Haw, pusFl T e

3 Highlight a line item record to be distributed and click the
associated Lookup button. The Distributions form appears.
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4 Enter Client, Project, Cost Code, Variation and Employee using the
Lookup buttons.

5 Enter the project Site and Trans Date, and modify the Chargeable
status if applicable.

6 Enter the quantity in the Quantity field.

7 Click <OK> to save and return to the Niku Financial Integrations
Menu screen.

8 Repeat the steps above for each line item, as necessary.
9 Click the Save icon to save the distributions.

Note: Refer to the How to Work with Document Selection
procedure in the Overview section for a detailed description of each
of the fields listed above.

Committed Costs Reports

PO costs distributed to Niku can be monitored using the Committed
Costs Report. This report identifies costs of items that have been
requested and/or ordered, but have not been received. Records are
grouped by client/project and are identified by PO number, line
number and description.

Parnd LS R (LT Comamittad Cost Rapo Pagalod 2

W
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I Bk paHrdn B i Cenrn Cisl i sty Fas Tiksd Lt
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Processing PO

The distributions assigned to a PO in Niku Financial Integrations follow
the PO through the third-party module receiving and matching
processes. When the PO generates a voucher, the distributions assigned
to the PO are used to generate distributions for the voucher line items. If
a partial shipment is received, distributions will be generated starting
with the first distribution line and continuing until the received quantity
is fully applied. Consequently, distributions should be entered in the
same order they will be allocated to clients. Additionally, manual
editing of the voucher distributions after the PO is generated is allowed.
The remaining PO distributions may also be modified in Niku Financial
Integrations to make adjustments.

The portion of a PO for which a voucher has been generated will no
longer be displayed on the Committed Cost Report. Any remaining
distributions for the PO will continue to be displayed as long as the PO
retains an Open status. When the PO is Closed in the third-party
module, no remaining distributions will be displayed.
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Accounts Payable

Costs entered through Accounts Payable (AP) may be distributed to
Niku using the Niku Financial Integrations. The items of an AP voucher
may be distributed at the voucher or line item level.

Once the AP voucher has been posted in the third-party module, the
distributions may be posted to Niku where any applicable mark-ups are
applied to the costs. If the cost originated with a purchase order (PO),
the cost distributions will flow through to the AP voucher. If a
distributed voucher is deleted in the third-party module, a manual WIP
adjustment is required in Niku. Recurring vouchers require each
scheduled payment to be distributed. The rest of this section will cover:

¢ Distributing AP Vouchers
¢ Processing Vouchers Originating from a PO
¢ Posting Distributions

¢ Reporting

Distributing AP Vouchers

Costs may be distributed to projects in Niku at the time of recording a
voucher. Once the voucher has been saved, the Niku Financial
Integrations can be accessed to distribute the costs. The distributions
may be modified until they are posted in Niku. Follow the procedure for
entering distributions in the Niku Financial Integrations section.

Processing Vouchers Originating from a PO

A PO must have a status of OPEN to be matched. The matching process
reconciles the PO amounts to the amounts invoiced and received.
Distributions entered in PO flow to the voucher through the matching
process. Modifications can be made to the distributions before they are
posted into Niku. Partial receipts are matched to distribution entries by
the entry order of the line items on the PO.
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Posting Distributions

A voucher must be posted in AP before the distributions can be posted
to Niku. The posting process follows the same steps outlined in the
Overview section.

Reporting

There are two basic reports available relating to AP posting. The first of
these reports is the Distributions Report. The detail distribution
transactions on this report are listed by company, module and
document number (e.g., voucher number).

Frivmact 01472198 1206 PM Distribwtions Report Pagelof 3
. . Comgenes rom " io ‘tzzezer
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The second report, Posting Results, displays the results of the last
posting run. The Valid Distribution section of the report displays the
transactions that posted successfully. The Posting Exceptions section
lists details for transactions that failed to post and provides a description
of the error(s).

Frinted: 421,99 12.08PM Pusting Exceptions Flepor Page2of 2
By Paul Aters Trinl Fam excegtians fom Apr 21 1999 12:06 20937FM
Company D i ] Company Mame: [£ ]
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Inventory

Inventory modules monitor items purchased for future sales. Items

maintained in inventory can be allocated to projects through

distributions. These items are taken out of inventory and distributed to

projects when a transfer is processed. Items that are returned and

restocked require a manual WIP adjustment in Niku to reverse the prior

distributions. Refer to the Overview section above for details on

entering distributions. Only 1V issues may be distributed through the

Niku Financial Integrations.

B Enter Inventory Transactions [Batch: IMIT-0000091]
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Process Engine

The Process Engine is used to launch procedures from Niku Financial
Integrations. These procedures are used to import transactions into, or
export transactions to, a specifically designed table in Niku. These tables
can be accessed by clients to import/export the transactions to third-
party accounting systems. There are three standard processes available
in Niku.

This section presents detailed documentation for the following standard
processes within Niku Financial Integrations:

¢ Export of Hours Process
¢ Import Costs from Payroll Process

¢ Import External Transactions Process

Export of Hours Process

The export process will allow companies to export data captured in the
Niku Time and Expenses modules by a range of dates into a pre-defined
table. This data may then be exported into virtually any third-party
payroll system. The data will be collected from the ppa_WIP table and
therefore will not be available until after time entries have been posted
to WIP within Niku. This export will populate a new table in Niku
entitled imp_WIPPayrollHoursExport. The data will then be available
for an outside conversion routine that will make it available to the
payroll systems import routine or a custom import routine. The layout
for the imp_WIPPayrollHoursExport’ table is outlined below:

Table Name = imp_W!IPPayrollHoursExport

Column Name Data Type Null

Exportkey Int NOT NULL IDENTITY
EmplyCode Varchar(10) NOT NULL
EmplyName Varchar(40) NULL

EmplySSN Varchar(20) NULL

EmplyClass Varchar(10) Null
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Table Name = imp_WIPPayrollHoursExport

Column Name Data Type Null
EmplyType Varchar(10) Null
EmplyStatus Varchar(10) Null
LocationID Varchar(10) Null
DepartCode Varchar(10) Null
EarningsType Int Null
EarningsCode Varchar(255) Null
Hours Decimal(15,2) Null
Imported Tinyint NOT NULL

The Export Payroll Information Process resides in the Process Engine, which is
located inside Niku Financial Integrations. The steps to run the process are
outlined in the following procedure.

How to Work with the Export of Hours Process

1 From the Main menu in Niku Financial Integrations, select
Process » Process Engine. The Process Selector dialog box appears.

Piocezz Selecton

x|

Process Name | Last Exacuted On Ok
Esponl Payroll Information [rewer tun) I_I
Espoit TLE Expensa Reparts To AP [mwar 1w Cancel
Import Exbamal Transachions [ un]
Irmipant Fagroll Achaal Costs [rewer iun]

Hiztoay....
| | i
Desciption

Expeat Payroll Infoemation based on ‘WIF labor enties.
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2 From the list box, select the Export Payroll Information Process and

click <OK>. The Export Payroll Hours from WIP dialog box
appears.

Export Pagroll Hours From WIP

Expot Options
Eniy - e ]
: Cancel
Location [<<ﬁ.LL>> =| 4'
Depatment | ccall>> =]
From Date | 1./1./90 i’_l

Setup... I

IoDate |Enr:u'99 :llJ

EXPORT OPTIONS

3 From the appropriate drop-down list boxes, select an entity,
location, and department. The defaults for everything but the dates
are set to ALL.

4  Select the From Date and To Date representing the Current Payroll
Period.

PAYROLL EXPORT SETUP

5 Click the Setup button and the Payroll Export Setup dialog box

appears.

HOLIDEY Holday
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This dialog box allows you to map Cost Codes to specific pre-defined
earnings types, and associate them with the exact Earnings Code
existing within the specific third-party Payroll package to which you
will exporting the imp_WIPPayrollHoursExport table.

Click the Add button to map to specific Cost Codes to the pre-defined
Earnings Types (Regular Hours, OT Hours, DT Hours, Vacation hours,
Sick Hours, Personal Hours, Jury Hours and Other Hours). The
Earnings Type Definition form appears.

Eamings Type Definition

| Cost Code || 0K
|Earmings Type [Overtime =] Cancel
|Egrn'r|gs Code I

6 Enteravalid code in the Cost Code field (one that has been set up in
Niku).

7 From the Earnings Type drop-down list, select one of the
predetermined earnings types.

8 Enter a corresponding code in the Payroll Earnings Code field.
9 Click <OK> and the Payroll Export Setup dialog box reappears.
10 Click CLOSE to exit the Payroll Export Setup form.

11 Click <OK> on the Export Payroll Hours from WIP dialog box to
run the Export.

Import Costs from Payroll Process
Costs associated with employees are usually held within a company’s

payroll system. Itis a time consuming task to calculate the actual cost for
each employee and update the employee records in Niku. The Import
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Costs from Payroll Process will allow companies to extract the cost data
from their payroll system and to populate a new table in Niku. This table
is entitled imp_PayrollActualCostsImport and its structure is as follows:

Req. Req.
Column Name Data Type NULL Entry  Value Comment
PayrollimportKey int NOT NULL None Reserved, autoincrement
IDENTITY key. Do not attempt to insert
data into this column.

EmplyCode Varchar(10) NOT NULL | Employee Code that this cost
entry is for.

FromDate Datetime NOT NULL | Beginning date of the period
that this cost entry applies to.

ToDate Datetime NOT NULL | Ending date of the period
that this cost entry applies to.

ActualCost Decimal(15, NOT NULL | Actual cost amount for the

2) employee for the specified
period.

Imported Tinyint NOT NULL M O Flag indicating whether this
cost entry has been imported
into Project Accounting.

ErrorCode int NOT NULL M o0 0 if no error, else the error

code corresponding to the
error message in the table
int_TransactionimportErrors

The actual costs entered in the imp_PayrollActualCostsimport table are
then imported into WIP via the Process Engine import process.
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How to Work with the Import Costs from Payroll Process

1 From the Main menu in Niku Financial Integrations, select
Process » Process Engine. The Process Selector dialog box appears.

Process Selector

Procaiss Mame: | Lasst Execated Or | oK |

£aport Faprall Inlsimabian 2R e 5.0 P
Esport TEE Espeniss Flepails Ta AP 070N 59 100 Carcel I
Impoit Evbennad Transactions 07261 233 5:02 P

072601539 5:03 P

| | |
Diesciiphon

Impout &Achual costs om the: Pagoll 5P table into WIP, recomputing the costs and
markups as needed.

2 From the list box, select the Import Payroll Actual Costs option and
click on <OK>. The Import Payroll Costs To WIP form appears.

Import Payroll Costs To WIP

B
| Location [<calls =| Cancel |
-

| Department | ccaLL>> =]

[~ Delete Praviouzl Imported Fows From The Import Table

| Cost Matrix To Update [ NONE > (0] =l

pecily the Enility [Company). Locstion and Depabment combinabions of
employess who pou wish bo impoet costs for from the Pagioll AP table,

3 Select an entity, location and department from the appropriate
drop-down list boxes.
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4  Select the Delete Previously Imported Rows From The Import Table
option to clear out old transactions

5 From the Cost Matrix To Update drop-down list, select the Cost
Matrix that needs to be updated.

Note: This Matrix can only contain Employees. The process will
create new rows in the matrix for the dates that are in the Import
Table and updates the actual costs for each valid employee. It will,
however, not update any wildcard information. If there is a rate
column it will set the rate to 0. Standard and Actual Costs will be the
same.

6 Click <OK> and the Payroll Import Exceptions report will
automatically display items that failed to import.

Import External Transactions Process

The Import External Transactions process allows the upload of large
volumes of transactions into Niku from multiple and varied data
sources. For example, if photocopy charges are tracked from a third-
party tracking system and telephone charges are received in a file
format, this data can be imported in the import table. The Import
External Transactions process uploads the data from the import table
into Niku where is it available for further processing.

The import table that has been created in Niku is entitled
imp_Transactionlmport. The imp_Transactionlmport table can be
populated with any Labor, Material, EQuipment or Expense transaction
types. The transactions in the table are uploaded into the
ppa_TransControl table of the designated Niku database. The
transactions imported into ppa_TransControl will be assigned a source
module of 50. The imp_Transactionlmport table structure is presented
in the table on the next page.
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Req. Req.
Column Name Data Type NULL Entry Value Comment
TransimportKey  int NOT None Reserved, autoincrement key.
NULL Do not attempt to insert data
IDENTITY into this column.
ExternalTransNo int NULL Transaction number from
source system (for reference
only)
ExternalBatchlD  varchar(20) NULL Batch number from source
system (for reference only)
TransType char(1) NULL L,M,Q, Computed by selected cost
X code or default cost code if cost
code left blank.
TransDate datetime NOT | Date of the transaction
NULL
Quantity decimal(15,4) NULL If not specified, defaults to 1
Rate decimal(15,2) NULL Optional bill rate per unit
Cost decimal(15,2) NULL Optional cost per unit
Chargeable tinyint NULL Flag indicating whether this
transaction is chargeable. If not
specified, defaults from
CostCode
OnSite tinyint NULL Flag indicating whether this
transaction occurred onsite. If
not specified, defaults from
CostCode
Notes varchar(255) NULL Notes associated with this
transaction
Client varchar(10) NOT | PA client code
NULL
Project varchar(12) NOT | PA project code
NULL
CostCode varchar(10) NULL PA costcode. If blank, uses PA

default CostCode.
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Req. Req.

Column Name Data Type NULL Entry Value Comment
Variation varchar(10) NULL PA costcodevariation, if any
EmplyCode varchar(8) NULL PA employee code. If blank,
uses PA default employee
code
Site varchar(10) NULL Project Site, if any. If none
supplied, the default site for
the project is substituted.
ImportStatus char(1) NOT M N “N” for not imported, “I” for
NULL imported, “V” for validated or
“E” for import error. When
populating thistable, the value
should always be set to N.
ImportDate datetime NULL ~ NULL NULL Date/Time that this
transaction was imported into
PA
ImportedBy varchar(8) NULL NULL if not imported, else the
user who imported them
ErrorCode int NOT ™M 0 0ifnoerror, else the error code
NULL corresponding to the error
message in the table
int_TransactionlmportErrors
WorkInt int NULL NULL, Reserved. This should be
0 populated with zero or NULL.
WorkBuf varchar(32) NULL NULL, Reserved. Thisshould be
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populated with NULL or
blank (H “)

How to Work with the Import External Transaction

Process

1 Populate the imp_Transactionlmport table.



2 From the Main menu in Niku Financial Integrations, select
Process » Process Engine. The Process Selector dialog box appears.

Proces: Hame | Last Exacuted On aK |
£port P aprall Infoimalan DR 2 S P
Esport TEE Espeniza Repails To AP OF/ 20N 593 10003 Cancel I
07/ 281999 5:02 PM
072801 53 5:00 P

mpiort Pageol &ciusl Costs

1] | I |

Desciiphon
Imnpaint E stesnal Warsactions into Project Accouniing's unposted ransaction lable.

3 Fromthe list box, select the Import External Transactions option and
click <OK>. The Transaction Import Options dialog box appears.

Transaction Import Ophions E

Date Range To Import
ge mg oK

|En:|mDate |;1,a'9|:| 3: :|

|1-=Date |m4;99 :Iﬂ

Cancel

[~ Walidate Transactions Orly
I Delete Imported Rows From Import T able

¥ Bun Exception Report &fter Processing Entries
™ Delete &ll Previously Imported Rows

4 From the Date Range To Import fields, select the From and To Dates.

5 Select one or more of the following options:

¢ Validate Transactions Only (without importing)
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¢ Delete Imported Rows From Import Table (delete transactions
that are imported in this batch)

¢ Run Exception Report After Processing Entries (for errors
analysis)

¢ Delete All Previously Imported Rows

6 Click <OK>. If the Run Exception Report After Processing Entries
option was selected, the Transaction Import Exceptions report will
automatically display a listing of errors encountered.

["] Fle Edt View Opfion: Windaw Help =l
D@ + e @8R & [Fear o &
[B x| % e %
Transaction Import Exceptions Pa
1/1/989 10 4714/99
TraaType  TransDate  Clieat Praoject CastCode  Variation Emplages Site Guanting Rate Chig  OaSite Emor Des
L s CLENTIS 150l SUFPORT Fal ] E [O | coo [lerewetomalen
L wem3 CLENTE a0 SUFPORT Pal 1 B O | 800 et
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